About the Series

The computer in present-day society is an indispensable tool facilitating communication and work. From huge machines weighing several tons, the computer has evolved into light, sleek yet powerful tools that dominate today’s knowledge society. Many previously complex and time-consuming tasks have been reduced to the mere touch of a few buttons on the keyboard. Basic computing skills like word processing are an essential requirement in today’s job market. The Internet has revolutionised the way people communicate and interact. Geographical distances are no longer a constraint for effective business transactions, information dissemination, and interpersonal interactions, as distances have been overcome through extensive, intricately-designed communication networks.

Today computer science is an academic subject in its own right, governed by scientific and mathematical principles. It is an integral part of what is commonly called STEM (Science, Technology, Engineering, and Mathematics). Due to its increasing importance, computer classes have become an essential part of the education curriculum around the world.

However, the trend has been to favour Information and Communication Technology (ICT) rather than the science behind computers. ICT in schools usually focuses only on teaching how to use office productivity software, such as, word processors, presentation software, and spreadsheets. We, as teachers, should be careful that we teach not only ICT, but also computing, especially in the lower classes. This is an important distinction because ICT primarily involves simply understanding and memorising commands. As a consequence many students may get the impression that there is not much of creativity involved in using computers. This may possibly result in students losing interest in what they mistakenly believe to be computing. Students are not introduced to how computers work and are not provided with the opportunity to be creative through computing activities that challenge them to use their logical and analytical abilities along with being creative.

Computer science education should be such that children later on, if they choose to do so, would be capable of making a meaningful contribution either to further advance our digital society or use digital media optimally in their chosen field of study or work. Computer education in schools should equip every child with the basic understanding of how computers work and with the possibilities of information technology in a knowledge-based society and economy. This has been the rationale for developing this third edition of the Keyboard series—Keyboard: Computer Science with Application Software.
The contents are based on the most recent feedback from teachers and incorporate the latest trends in computer education. We have taken particular care to update facts and figures, and to include the latest advancements in the field of information and communication technology. Thus, trendsetting topics such as social networking and cloud computing have been explained along with devices such as smartphones and tablets. Also, in keeping with the times, there is greater focus on animation and web-designing concepts.

The series introduces the subject in a language that is simple and direct. Technical jargon is used only where necessary and all such terms are defined at the end of each chapter. Comic strips, icons, cartoon characters, and illustrations make the learning process an enjoyable experience.

*Keyboard: Computer Science with Application Software* is an advanced course in computer science meant for those schools that wish to teach creative application software, such as Flash, HTML, Photoshop, and Dreamweaver, along with the basic concepts of computers, computer programming, and the Internet. In keeping with the times it also introduces students to sound (Audacity) and video-editing (Lightworks) software.

**COURSE FEATURES AND HIGHLIGHTS**

Each chapter in *Keyboard: Computer Science with Application Software* starts with an engaging introduction in comic strip format presenting a conversation between two characters, Goggle and Toggle. Goggle represents an average primary and middle school student, while Toggle is an animated laptop and an expert in computer science. Toggle helps Goggle understand all that is taught about computers and computer software in the series. The series has a hands-on approach to learning with text supported by relevant screenshots, and plenty of practical exercises. The MS Office screenshots are based on MS Office 2013, with the compact and user-friendly Windows 7 as the operating system.

**Practice Time, Exercises, In the Lab, and Group Project**

**Practice Time** is a feature that has been a part of all the computer science series we have written, and it has been found by teachers to be a very useful feature. We continue with it in *Keyboard: Computer Science with Application Software* also. The feature provides practical exercises after every major topic, in which the student applies the concept(s) learnt in the previous section to solve a practical problem. The detailed solution is given after the question, so that students are able to understand the practical application of a particular concept on their own. This frees the teacher from the process of trying to individually assess whether all the students have properly grasped the concept.

The **Exercises** and **In the Lab** questions in the series deserve particular mention, as they have been developed according to Bloom’s Taxonomy. The exercises in each chapter have sufficient theoretical and practical questions for concept application.

**Application-Based Questions** is a special analytical section within Exercises, aimed at encouraging students to evaluate a picture or a situation, and answer questions based on them.

The **In the Lab** questions are similar to those under **Practice Time** except that the solutions are not given. The questions too are more complex than those found under **Practice Time**. In both, however, the questions describe
a variety of situations across subjects. Thus, both attempt to integrate the use of computers with problem-solving in other subjects.

**Group Projects** encourage the students to work in collaboration with their peers and implement what they learnt in the lessons.

**Worksheets and Assessment Papers**

**Worksheets** have been introduced in Classes I to V, while for Classes VI to VIII **Assessment** and **Comprehensive Assessment** papers have been included.

**Teaching Resources**

The teacher’s resources for the *Keyboard: Computer Science with Application Software*, series have two components: (a) Teaching Guides and (b) Teacher’s Digital Resources.

**Teaching Guides**

The Teaching Guides accompanying each of the coursebooks is carefully structured to provide useful support to teachers.

Each Teaching guide contains the following:

- A **Lesson Plan** that details the periods recommended for a particular chapter, the topics therein, the expected learning outcomes at the end of each topic, and the digital support available for each chapter. This is intended to assist teachers in respect of overall planning. Teachers may go through the lesson plan before stepping into the class or may use the recommendations for creating their own.

- A set of **chapter-wise Worksheets** follows the lesson plans, and has questions in the form of Crossword Puzzles, Word Searches, Jumbled Words, etc. designed to reinforce conceptual understanding.

- In addition to the **Worksheets**, a set of **chapter-wise test papers** has also been provided, which may be used by teachers to create their own assessment papers, or may be used as they are for classroom tests.

- The complete **Answer Key** to the Coursebook Exercises has been given in the teaching guide, including that for the In the Lab questions, Group Project, Worksheets/Assessment papers, Revision Questions, and the Cyber Olympiad Questions.

**Digital Resources**

The teacher’s digital support for the series is accompanied by a **Test Generator**.

This comprehensive and easy-to-use **Test Generator** is an effective assessment tool designed to benefit teachers by enabling them to create a variety of test papers.

It has two sections: (a) Coursebook questions (b) Questions beyond the coursebook.

Both include an extensive pool of questions, such as multiple choice, true or false, fill in the blanks, short answer, and long answer questions, as well as lab exercises wherever relevant. Answers have been provided to enable efficient and effective evaluation. The **Test Generator** allows the teacher to create test papers for one or more chapters, with a mix of questions from both the sections. The Student’s Books, and the accompanying Teaching Guides and teacher’s digital support, together form a complete package enabling one to teach the subject effectively.
Continuous and Comprehensive Evaluation

Learning takes place in a variety of ways — through experience, making and doing things, experimentation, reading, discussion, asking, listening, thinking and reflecting, and expressing oneself in speech, movement or writing. All these modes of learning are possible both individually and in groups. It would thus be advantageous for children to be given the opportunity to involve themselves in as many of these activities as possible.

CONTINUOUS AND COMPREHENSIVE EVALUATION (CCE)

The primary objectives of this system are (1) to maintain continuity in evaluation and (2) to reliably assess broad-based learning and behavioural outcomes.

In this system the term ‘continuous’ is meant to emphasize that evaluation of a student’s progress is a continuous process rather than an event. It is spread over the entire span of an academic session, and means regularity of assessment and unit-testing. It also includes a diagnosis of learning gaps, the use of corrective measures, retesting, as well as self-evaluation.

The term ‘comprehensive’ suggests that the system should cover both scholastic and co-scholastic aspects of a student’s growth and development.

This system expects assessment to be both formative and summative. Formative assessment is a tool used by the teacher to continuously monitor student progress in a supportive environment. It involves regular descriptive feedback, a chance for the student to reflect on the performance, take advice and improve upon it. If used effectively it can improve student performance tremendously.

Summative assessment is carried out at the end of a course of learning. It measures or ‘sums-up’ how much a student has learned from the course. It is usually a graded test, i.e., it is marked according to a scale or set of grades.

It has been found that assessment that is predominantly of a summative nature will not by itself be able to yield a valid measure of the growth and development of the child. It, at best, certifies the level of achievement only at a given point of time.

The paper-pencil tests are basically a one-time mode of assessment and to exclusively rely on it to decide about the development of a child is both unfair and unscientific. Over-emphasis on examination marks makes children assume that assessment is different from learning. Besides encouraging unhealthy competition, the reliance on a summative assessment system also results in great stress and anxiety among learners.

The Keyboard: Computer Science with Application Software, series, comprising of Student’s Books, Teaching Guides, and Digital Resources, has a number of features that aid both continuous and comprehensive evaluation.

CONTINUOUS EVALUATION

Coursebooks

Beginning of Instruction (Formative Assessment)

- The introductory dialogue at the beginning of each chapter between Goggle and Toggle is a starter to the chapter topic and can be employed to test the prior knowledge of students by using the dialogue to ask for possible solutions or an answer to Goggle’s question. For example, in the following dialogue you can also ask them what is the alternative to clicking the Run button.
During Instruction (Formative Assessment)

- The conceptual grasp of students can be assessed during instruction through Practice Time, which has been placed after every major topic in the Student’s Book, by observing how fast they carry out the task as given. A couple of questions may also be added to test their understanding of the concept. For example, in the question below students may be asked if they can use the `tl` command in the solution to this question instead of the `tr` command.

### PRACTICE TIME

Tina wants to draw a rectangle of breadth 40 steps and length 60 steps in KTurtle using the `turnright (tr)` command. Can you help her out?

#### SOLUTION

1. Tina should type the code given alongside in the KTurtle Editor pane.
2. After typing the code, she should click the Run button.
3. The output will appear as given here.

Note: Try doing the same using the `tl` command also.
End-of-Chapter (Summative Assessment)

- At the end of the chapter the student can be tested on acquired knowledge through the objective and descriptive questions of the Exercises, the Application-Based Questions, and on the practical application of concepts through In the Lab questions, and Group Project.

**In the Lab**

1. Amir has designed a New Year greeting card in Paint as shown below. Make a New Year greeting card of your own, using the various tools in Paint, for your teacher.

**Application-Based Questions**

a. Observe the given figure on the right and answer the following questions:
   i. Which tool is selected in the figure?
   ii. Name the modifier that has been used to draw line A.
   iii. Name the modifier that has been used to draw line B.
   iv. Which modifier will you use to draw lines without any modification?

**End-of-Unit and Term (Formative as well as Summative Assessment)**

- Assessment at the end of a unit, or a set of three or four chapters, is facilitated through Worksheets in classes I to V.

**Teaching Guides**

The Teaching guides provide the following support for formative and summative assessment:

- **Worksheets, one for each chapter**, have questions in the form of Crossword Puzzles, Word Searches, Jumbled Words, etc. designed to reinforce conceptual understanding.

- **Test papers, one for each chapter**, which may be used by teachers by photocopying them in a larger format for classroom tests.

**Digital Resources**

The downloadable digital resources are for the series provided accompanied with Test Generator.

The Digital resource for Keyboard: Computer Science with Application Software, includes:

- **Animations** for the theoretical chapters such as that on operating systems, history of computers, input and output devices, etc. that offer an interesting audio-visual element to technically complex or difficult concepts. There are one or more modules for each such chapter which may be paused at relevant points and feedback taken on what the children have seen, heard, and understood.

- **Demo Videos** that are linked to one of the Practice Times in software chapters (those chapters that describe the features and commands available in a software), and present a step-by-step audio-visual guide to solving the problem described in that particular Practice Time question. One or more objective type question(s) have been introduced at (a) strategic point(s) under the feature Rapid Round during the demo to encourage children to participate in the solution to the problem. These questions could be also be used as a formative assessment tool.

- **Interactive Exercises** The objective type questions have been made interactive in the form of pop-up screens in which the right answer can be typed in or clicked. Clicking Submit will give you feedback, hence these can be used as a formative assessment tool for quick evaluation.
• **Printable documents** for every chapter in the form of soft copies of the worksheets and test papers given in the Teaching Guides. The teacher is free to use either version of the worksheets and test papers as formative assessment tools.

• Additional projects, Cyber Olympiad questions for practice, revision questions, and sample assessment papers (in classes 6 to 8).

The Test Generator accompanying digital resources is an effective assessment tool designed to benefit teachers by enabling them to create a variety of test papers.

It has two sections: (a) Coursebook questions  (b) Questions beyond the coursebook.

Both have an extensive pool of questions including multiple choice, true or false, fill in the blanks, very short answer, and short answer questions, as well as lab exercises wherever relevant. The Test Generator can be used to create test papers for one or more chapters, with a mix of questions from both the sections. The wide variety of objective and descriptive type of questions makes the tool flexible enough for teachers to employ it either for formative or for summative assessment. Answers have also been provided for these questions to aid efficient and effective evaluation by teachers.

### COMPREHENSIVE EVALUATION

Comprehensive evaluation involves, as explained above, both the scholastic and co-scholastic aspects of a student’s growth and development. It aims to assess the student not only in the area of pure knowledge but also in the areas of their analytical and creative ability, as well as in their general attitudes and aptitudes.

The key features in *Keyboard: Computer Science with Application Software*, have been designed to provide both scholastic and co-scholastic development.

**Scholastic**

• The features such as Did You Know?, Fast Forward, Top Tip, Tricky Terms, and Memory Bytes, enhance and reinforce conceptual knowledge.

---

**Did you Know?**

One point equals \( \frac{1}{72} \)th of an inch.

**Fast Forward**

Font dialog box  
Ctrl + D

**Top Tip**

Starter images are backgrounds with outlines of images, or 3D photographs, that you can use in Tux Paint.

**Tricky Terms**

- Template: A pre-defined design layout that saves time while designing
- Objects: The elements you place in your publication
- Guides: They are horizontal and vertical lines
- Scratch Area: The grey area around the publication page where objects can be placed before insertion in the publication page
- Drop Cap: A text-formatting style that enlarges the first letter of the selected text

**Memory Bytes**

- The AutoFill feature lets you quickly enter a predefined series of data.
- There are two ways to create custom lists: by importing the list or by entering the list in the Custom Lists dialog box.
- Filtering selectively displays rows/columns that meet the criteria specified by the user.
- Conditional formatting allows you to set a cell’s format according to the conditions you specify.
Co-Scholastic

- The features such as Computer Manners, Projects, and the design of the practical exercises focus both on scholastic and co-scholastic areas by creating awareness on ethical and correct use of computers, as well as the use of computers as a tool for applying their creativity and enhancing their problem-solving skills.

**Computer Manners**

- [Image of computer students using software]

**Application-Based Questions**

1. Observe the given figure on the right and answer the following questions:
   a. Which tool is selected in the figure?
   b. Name the modifier that has been used to draw line A.
   c. Name the modifier that has been used to draw line B.
   d. Which modifier will you use to draw lines without any modifications?
   e. Danya has to create a cartoon character using tools available in Flash CS3. Which tool will she use for the following purposes?
      i. Paint freely on the stage
      ii. Draw a square
      iii. Fill with gradient inside the shape

**Projects**

- [Diagram of a figure to be drawn using KTurtle]

**APPLICATION**

Type the following commands and execute it in KTurtle. Draw the figure you see on the canvas in the space provided.

```kturtle
reset
canvascolor 255,0,0
pencolor 0,255,0
penwidth 5
go 150,250
fw 120
tr 90
fw 100
tr 90
fw 120
tr 90
fw 100
bw 40
tr 90
fw 50
tr 90
fw 20
tr 90
fw 50
tr 90
fw 60
tr 90
fw 120
tr 45
fw 70
tr 90
fw 70
tl 135
go 60,250
fontsize 40
pencolor 0,0,255
print "This is my house"
spritehide
```

Find out how many rectangles there are in the figure.

**In The Lab**

1. Amir has designed a New Year greeting card in Paint as shown below. Make a New Year greeting card of your own, using the various tools in Paint, for your teacher.

[Image of a New Year greeting card in Paint]
SCHEME OF WORK AND LESSON PLANS

- A Scheme of work and Lesson Plan has been devised for each chapter which details the number of periods recommended for that chapter, the topics covered in that chapter, the recommended topic-wise allocation of periods, the learning outcomes, and the downloadable digital resources available for that chapter.
- The total number of periods in a year for computer science has been taken at 36 assuming one period in a week for the subject.
- Teachers may go through the lesson plan before stepping into the class. However, this is a proposed lesson plan, and teachers are free to modify it as per their teaching styles, sequence, and requirements in respect of the chapters.
## SCHEME OF WORK*

<table>
<thead>
<tr>
<th>Chapter Title</th>
<th>In this Chapter</th>
<th>Topic-wise Allocation of Periods</th>
<th>Learning Outcomes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. The Computer System</td>
<td>Classification of Computers by Size</td>
<td>2</td>
<td>The student should be able to:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• classify computers by size.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• differentiate amongst the different types of computers—mobile computers, mini computers, microcomputers, mainframes, and supercomputers.</td>
</tr>
<tr>
<td></td>
<td>Hardware</td>
<td>3</td>
<td>• define the term, hardware.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• describe the different input devices—barcode reader, magnetic ink character reader, etc.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• describe the different output devices—LCD Projector, Braille Printer, Plotter.</td>
</tr>
<tr>
<td></td>
<td>Software</td>
<td>2</td>
<td>• define the terms: software and program.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• explain the terms: system software, operating system, and driver.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• differentiate amongst assembler, compiler, and interpreter.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• describe the two types of application software—packages and utilities.</td>
</tr>
<tr>
<td></td>
<td>Computer Languages</td>
<td>1</td>
<td>• discuss the classification of computer languages—low-level languages and high-level languages.</td>
</tr>
<tr>
<td>2. Formatting Data in Excel 2013</td>
<td>Font Formatting</td>
<td>2</td>
<td>The student should be able to:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• explain the term, font.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• recognise the functions of all the buttons in the Font group on the HOME tab.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• set the cell colour, pattern, and border.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• apply different formatting features like font colour, text style (bold, italics and underline), and font size.</td>
</tr>
<tr>
<td></td>
<td>Alignment and Orientation of Data</td>
<td>2</td>
<td>• explain the terms: Alignment and Orientation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• recall the functions of all the buttons in the Alignment group on the HOME tab.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• appropriately apply the different types of text alignment in a cell.</td>
</tr>
<tr>
<td></td>
<td>Number Formatting</td>
<td>1</td>
<td>• orient data in a cell at different angles.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• effectively use the Wrap Text and Merge &amp; Centre features.</td>
</tr>
<tr>
<td></td>
<td>Cell Styles</td>
<td>1</td>
<td>• recall the use of all the buttons in the Number group on the HOME tab.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• format numeric data.</td>
</tr>
<tr>
<td></td>
<td>AutoFill</td>
<td>2</td>
<td>The student should be able to:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• explain the working of the AutoFill handle.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• use the AutoFill options effectively.</td>
</tr>
<tr>
<td>3. Advanced Features of Excel 2013</td>
<td>Flash Fill</td>
<td>1</td>
<td>• describe what the Flash Fill feature does.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• differentiate between AutoFill and Flash Fill.</td>
</tr>
</tbody>
</table>

* The topic-wise allocation of periods for each chapter may vary, as per the individual class requirements.
<table>
<thead>
<tr>
<th>Chapter Title</th>
<th>In this Chapter</th>
<th>Topic-wise Allocation of Periods</th>
<th>Learning Outcomes</th>
</tr>
</thead>
</table>
| Sorting       | 1               | • explain why sorting is required.  
• sort using single or multiple columns.  
• organise data into levels. |
| Filtering     | 1               | • describe what filtering means.  
• demonstrate how filtering is applied.  
• explain the different criteria that can be used for filtering. |
| Conditional Formatting | 1           | • explain the meaning of conditional formatting. |
| More Sorting and Filtering | 1         | • sort or filter data based on cell colour. |
| 4. Introducing Publisher 2013 |                  |                                | The student should be able to:  
• start Publisher 2013.  
• explain the difference between built-in and online templates.  
• customise the template.  
• identify the different parts of the Publisher interface. |
| Starting Publisher 2013 | 1           | • insert text boxes.  
• format text and text boxes.  
• save publications with .pdf and .pub extensions.  
• print, close, and exit a publication. |
| Publisher Interface |                  |                                | |
| Working with Publisher 2013 | 2.5          | • create your own publication design from scratch. |
| Creating a New Blank Publication | 0.5 | • connect text boxes. |
| Connecting Text Boxes | 1           | • explain the Drop Cap feature.  
• describe Number Styles, Stylistic Sets, Swash, and Ligatures. |
| Typography    | 1               | • explain what the scratch area and thumbnails are.  
• select multiple objects in scratch area.  
• arrange pictures as thumbnails and swap pictures. |
| Scratch Area   | 2               | • insert shapes in a publication.  
• resize and rotate objects, fill shapes style shapes, apply shape outline and shape effects. |
| Working with Shapes | 1           |                                | |

* The topic-wise allocation of periods for each chapter may vary, as per the individual class requirements.
<table>
<thead>
<tr>
<th>Chapter Title</th>
<th>In this Chapter</th>
<th>Topic-wise Allocation of Periods</th>
<th>Learning Outcomes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with Building Blocks</td>
<td>1</td>
<td></td>
<td>• describe what building blocks are.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• define the four types of building blocks.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• insert building blocks in a publication.</td>
</tr>
<tr>
<td>6. Basics of MS Small Basic</td>
<td>Basics of Small Basic</td>
<td>2</td>
<td>The student should be able to:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• start a Small Basic program.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• identify the various components of the main screen.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• write a simple program and explain how to save, execute and open a program.</td>
</tr>
<tr>
<td>Elements of Small Basic</td>
<td>7</td>
<td></td>
<td>• explain the rules of Small Basic programming.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• define constants and variables.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• differentiate between the two types of constants.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• list the rules for naming variables.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• differentiate between numeric and string variables.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• explain what an assignment statement is.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• define the terms: Operators and Expression.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• describe the types of operators with examples.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• define concatenation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• write comments in a program.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• define an object, a property, and a method.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• differentiate between the Write( ) and WriteLine( ) methods.</td>
</tr>
<tr>
<td>Conditional Statements in</td>
<td>2</td>
<td></td>
<td>• explain the TextWindow object in detail.</td>
</tr>
<tr>
<td>Small Basic</td>
<td></td>
<td></td>
<td>• differentiate between Read( ) and ReadNumber ( ) methods.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• describe math library functions with examples.</td>
</tr>
<tr>
<td>7. The Internet as a Post</td>
<td>Internet Terms and Addresses</td>
<td>2</td>
<td>The student should be able to:</td>
</tr>
<tr>
<td>Office</td>
<td></td>
<td></td>
<td>• define the following terms:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>– ISP</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>– Modem</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>– Web page</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>– Web Browser</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>– Website</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>– WWW</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>– Home page</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>– URL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1</td>
<td>• differentiate between Number Addressing and Letter Addressing systems with examples.</td>
</tr>
<tr>
<td>Chapter Title</td>
<td>In this Chapter</td>
<td>Topic-wise Allocation of Periods</td>
<td>Learning Outcomes</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Email Services                |                 | 2                               | • list the advantages of email.  
• explain the parts of an email address.  
• list the various features of an email service.  
• demonstrate how to open an email account.  
• demonstrate how to compose and send emails.  
• demonstrate how to create signatures.  
• explain why it is important to sign out properly. |
| Information Retrieval         |                 | 2                               | • explain what a search engine is.  
• demonstrate how to use a search engine to find information.  
• explain how the Internet is a great tool for education.  
• search for people on the Internet |
| Education Through the Internet|                 |                                 |                                                                                                                                               |
| Finding People on the Internet|                 |                                 |                                                                                                                                               |
| 8. Introduction to Flash CS3  | Getting Started with Flash | 3                               | The student should be able to:  
• explain the use of the Flash software.  
• demonstrate how to start Flash CS3.  
• explain the components of the Flash window.  
• explain different areas of the Tools Panel.  
• explain the importance of the Property Inspector  
• explain the use of rulers |
|                               |                 |                                 | • demonstrate how to create a new Flash document  
• demonstrate how to set document properties  
• demonstrate how to save and open a file |
| Drawing Modes in Flash        |                 | 1                               | • differentiate between Merge Drawing mode and Object Drawing mode in Flash |
| Selection Tools               |                 | 2                               | • demonstrate how to use the different selection tools–Arrow tool, Lasso tool |
| 9. Drawing Tools in Flash     | Drawing Tools   | 5                               | The student should be able to:  
• demonstrate the use of the Line Tool, Rectangle Tool, Rectangle Primitive Tool, Oval Tool, Oval Primitive Tool, PolyStar Tool, Pencil Tool, Brush Tool, Paint Bucket Tool, Ink Bottle Tool, Eraser Tool.  
• differentiate between the Rectangle Tool and the Primitive Rectangle Tool  
• differentiate between the Oval Tool and the Primitive Oval Tool.  
• create a new gradient.  
• demonstrate how to use the Ink Bottle Tool, and the Eraser Tool. |
| Reshaping Lines and Shapes    |                 | 1                               | • demonstrate how to reshape lines using the Arrow Tool. |
| 10. Creating Animations in Flash CS3 | Creating Symbols | 2                               | The student should be able to:  
• explain the need for creating Symbols.  
• convert a drawing into a Symbol. |

* The topic-wise allocation of periods for each chapter may vary, as per the individual class requirements.
<table>
<thead>
<tr>
<th>Chapter Title</th>
<th>In this Chapter</th>
<th>Topic-wise Allocation of Periods</th>
<th>Learning Outcomes</th>
</tr>
</thead>
</table>
| Understanding the Timeline    | 2               | • explain the components of the Timeline window.  
|                               |                 | • differentiate between frames and keyframes.  
|                               |                 | • insert frames and keyframes.  
|                               |                 | • delete a frame.  |
| Creating Animations           | 4               | • create frame-by-frame animations.  
|                               |                 | • create a motion tween.  
|                               |                 | • create a shape tween.  |

*The topic-wise allocation of periods for each chapter may vary, as per the individual class requirements.*
LESSON PLANS*

Chapter 1 The Computer System

Time for each lesson: 40 minutes

Resources: a laptop, a projector (if available), safety pins, a sheet of paper, cut out alphabets, saved pictures of different computers

Introduction (5 minutes)
Start off the lesson by showing students images of different types of computers (by size classification) already saved in the laptop. Encourage them to share whatever information they have regarding the images, before giving them a brief introduction on the history of computers and where they were used. You may also ask students to name a few peripheral devices and software that they have seen or used before.

Explanation (25 minutes)
Briefly describe input and output devices and explain in detail the devices mentioned in the chapter. Next ask the students to silently go through ‘SOFTWARE’ heading in the chapter. You can then write down the names of a few well known software on the board, for example Windows 10, MS Word, Norton, Linux etc., and ask students to categorise them either as system software or application software. Following this activity, you can thoroughly explain the concept of software to students.

In order to demonstrate the workings of a braille printer, you can ask students to pin cut out alphabets on sheets of paper, using a safety pin. They can exchange their papers with their seatmates, run their fingers over the pinned alphabet, and try to identify the alphabet. This activity will help them understand how braille printers aid the blind in reading.

You can assign any of the following tasks for classwork.
- Exercises
- In the Lab
- Application Based Questions
- Group Project

Assessment
Students’ learning should be assessed on Bloom’s taxonomy model, as well as on their class participation, enthusiasm, inquiry, and team work. At the end of the lesson, students will be able to:
- classify computers by size.
- differentiate among the different types of computers-mobile computers, minicomputers, microcomputers, mainframes, and supercomputers.
- define the term hardware.
- describe the different input devices- barcode readers, magnetic ink character reader, etc.
- describe the different output devices LCD projector, braille printer, plotter.
- define the terms: software and program.
- explain the terms: system software, operating software, and driver.
- differentiate amongst assembler, compiler, and interpreter.
- describe the two types of application software-packages and utilities.
- discuss the classification of computer languages: low-level languages and high-level languages.

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.
Conclusion (10 minutes)
Encourage students to give you a recap of the main points they have learnt in the lesson. Have a discussion on any one on the topics mentioned in the teacher’s notes, given at the end of the chapter.

Chapter 2 Formatting Data in Excel 2013

Time for each lesson: 40 minutes

Resources: a laptop, a projector (if available), a sample table of daily activities on excel sheet saved on your laptop, MS Excel software, computer lab

Note: Ask students to go through the chapter at home once so that they are able to better comprehend the concepts taught in class.

Introduction (8 minutes)
You may start off the lesson by asking students to draw a timetable of their daily activities from Monday to Friday, starting from the time they reach home to the time they go to bed. Give them around 3 minutes for this activity (a rough sketch will be good enough). After they are done, show students the MS Excel table saved in your laptop and ask them to identify the software used to create it. You may then have a brief discussion with your students about the advantages of using MS Excel. Encourage them to share whatever knowledge they have regarding the software.

Explanation (25 minutes)
Let students read from the textbook. You may take your students to the computer lab and show them the different ways of formatting text and numbers on MS Excel. Have them perform the practice time questions in the computer lab. (In case there is a shortage of computers, then divide the practice time questions into 3 parts. Divide the students in groups of 3 and have them practice different parts of a question.)

In order to test their knowledge, at the end of the session you may format text and numbers in different ways and ask students to identify the type of formatting that has been done. You can then assign any of the following tasks for classwork.
- Exercises
- In the Lab
- Application Based Questions
- Group Project

Assessment
Students’ learning should be assessed on Bloom’s taxonomy model, as well as on their class participation, enthusiasm, inquiry, and team work. At the end of the lesson, students will be able to:
- explain the term ‘font’.
- recognise the functions of all the buttons in the font group on the home tab.
- set the cell colour, pattern, and border.
- apply different formatting features like font colour, text style (bold, italics, and underline), and font size.

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.
• explain the terms: alignment and orientation.
• recall the functions of all the buttons in the alignment group on the home tab.
• appropriately apply the different types of text alignment in a cell.
• orient data in a cell at different angles.
• effectively use the text wrap and merge & centre features.
• recall the use of all the buttons in the number group on the home tab.
• format numeric data.
• explain why cell styles are required.
• apply a cell style.

Conclusion (7 minutes)

Encourage students to give you a recap of the main points they have learnt in the lesson. Ask about the feature they like the most in MS Excel program. Have a discussion on any one on the topics mentioned in the teacher’s notes, given at the end of the chapter.

Chapter 3 Advanced Features of Excel 2013

Time for each lesson: 40 minutes

Resources: a laptop, a projector (if available), MS Excel, computer lab

Note: Ask students to go through the chapter at home once so that they are able to better comprehend the concepts taught in class.

Introduction (7 minutes)

You may commence the session by having a discussion with your students about the reading material that was assigned to them. Encourage them to share their doubts and discuss anything that they found interesting in the chapter. You can also conduct an activity in class by writing a few names on the board and asking students to note them down on a piece of paper, but in ascending order. You can wind up the introduction by explaining how MS Excel can make this task, and many other tasks, a lot easier by using a few simple commands.

Explanation (25 minutes)

In the computer lab, demonstrate how the different features work in MS Excel (you may use a projector so that all students are able to view the screen properly). You can also mention the advantages of each feature alongside. For example, how Flash Fill is helpful in that it helps save time and minimises errors etc. Have the students perform the practice questions in the computer lab as part of their classwork. Elicit responses from them on how they think MS Excel has made working with tables and numbers a lot easier. Finally you can have them come up with 3 other uses of MS Excel.

You can assign any of the following tasks for classwork (other than practice work).

• Exercises
• In the Lab
• Application Based Questions
• Group Project

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.
Assessment

Students’ learning should be assessed on Bloom’s taxonomy model, as well as on their class participation, enthusiasm, inquiry, and team work. At the end of the lesson, students will be able to:

• explain the working of the autofill handle.
• use the autofill options effectively.
• create, edit, or delete a custom list.
• describe what the flash fill feature does.
• differentiate between autofill and flash fill.
• explain why sorting is required.
• sort using single or multiple columns.
• organise data into levels.
• describe what filtering is applied.
• explain the different criteria that can be used for filtering.
• explain the meaning of conditional formatting.
• effectively apply conditional formatting.
• explain how selected rows are highlighted.
• sort or filter data based on cell colour.

Conclusion (8 minutes)

Encourage students to give you a recap of the main points they have learnt in the lesson. Have a discussion on any one on the topics mentioned in the teacher’s notes, given at the end of the chapter.

Chapter 4 Introducing Publisher 2013

Time for each lesson: 40 minutes

Resources: a laptop, a projector (if available), Publisher 2013, computer lab

Note: Ask students to go through the chapter at home once so that they are able to better comprehend the concepts taught in class.

Introduction (7 minutes)

You may start off the lesson by discussing how celebrations and exchanging cards have become a norm particularly on special events like birthdays, weddings, final exam results, etc. Have students share ideas on what type of cards they exchange on their birthdays. And from there you can introduce Publisher 2013 as a software that helps users create different documents, including cards.

Explanation (25 minutes)

In the computer lab explain to students how Publisher 2013 can be used to create a variety of documents like sports team banners, event flyers, certificate awards, etc. Make sure that students are able to relate with every example that you give. You may then demonstrate the workings of Publisher 2013, how users have the option of making their own publication from scratch or using one of the pre-designed templates, or how text can be included in the publication and formatted as well.

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.
It is recommended that you have students perform Practice Time questions as part of their classwork. This will allow them to practice what they’ve learnt during the lesson.

You can assign any of the following tasks for classwork (other than practice work).

- Exercises
- In the Lab
- Application Based Questions
- Group Project

Assessment

Students’ learning should be assessed on Bloom’s taxonomy model, as well as on their class participation, enthusiasm, inquiry, and team work. At the end of the lesson, students will be able to:

- start publisher 2013.
- explain the difference between built-in and online templates.
- customise the template.
- identify the different parts of the publisher interface.
- insert text boxes.
- format text and text boxes.
- save publications with .pdf and .pub extensions.
- print, close, and exit a publication.
- create your own publication design from scratch.
- connect text boxes.
- explain the drop cap feature.
- describe number styles, stylistic sets, swash, and ligatures.

Conclusion (8 minutes)

Encourage students to give you a recap of the main points they have learnt in the lesson. Have a discussion on any one on the topics mentioned in the teacher’s notes, given at the end of the chapter.

Chapter 5 Graphics in Publisher 2013

Time for each lesson: 40 minutes

Resources: a laptop, a projector (if available), Publisher 2013, computer lab

Note: Ask students to go through the chapter at home once so that they are able to better comprehend the concepts taught in class.

Introduction (5 minutes)

You may start off the lesson by briefly recapping the important points of the previous lesson. You can ensure that students remain engaged in this discussion by encouraging them to briefly recap the previous chapter in their own words.

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.
Explanation (25 minutes)

In the computer lab explain to students how they can also work with images on Publisher 2013. Thoroughly describe the various ways in which images can be formatted including aligning, resizing, styling, scratch areas, thumbnails, shapes, building blocks etc. Ensure that students are given ample time to perform some of these function on their own. You can also ask students to perform the Practice time questions individually or in groups of 3. All of this will allow students to practice what they’ve learnt during the lesson.

You can assign any of the following tasks for classwork (other than practice work).

- Exercises
- In the Lab
- Application Based Questions
- Group Project

Assessment

Students’ learning should be assessed on Bloom’s taxonomy model, as well as on their class participation, enthusiasm, inquiry, and team work. At the end of the lesson, students will be able to:

- recall the different ways of inserting pictures in a publication.
- crop a picture.
- wrap text in different ways around a picture.
- apply a picture style.
- move, align and resize a picture.
- explain what a caption means.
- add a caption to a picture.
- set a picture as a background.
- explain what a scratch area and thumbnails are.
- select multiple objects in scratch area.
- arrange pictures as thumbnails and swap pictures.
- insert shapes in a publication.
- resize and rotate objects, fill shapes, style shapes, apply shape outline and shape effects.
- describe what building blocks are.
- define the four types of building blocks.
- insert building blocks in a publication.

Conclusion (10 minutes)

Encourage students to give you a recap of the main points they have learnt in the lesson. Have a discussion on any one on the topics mentioned in the teacher’s notes, given at the end of the chapter.

Chapter 6 Basics of MS Small Basic

Time for each lesson: 40 minutes

Resources: a laptop, a projector (if available), MS Small Basic, computer lab

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.
Note: Ask students to go through the chapter at home once so that they are able to better understand the concepts taught in class.

Introduction (5 minutes)
You may begin your class by holding a small discussion with students regarding what the reading material that was assigned to them. Acknowledge the fact that MS Small Basic is a new concept to them and that at the end of this lesson they will be able to write a few codes themselves.

Explanation (25 minutes)
In the computer lab, introduce students to MS Small Basic. Explain to them the various terminologies used in the chapter like constants, variables, operators, expressions, arithmetic and logical operators, comment, object, property, statement etc. Also, ensure that students are aware of the difference between Write () and WriteLine (), and Read () and ReadNumber ()

You may give students the time to perform the examples given in the chapter. You can also ask them to perform the Practice time questions individually or in groups of 3. All of this will allow students to practice what they’ve learnt during the lesson.

You can assign any of the following tasks for classwork (other than practice work).

- Exercises
- In the Lab
- Application Based Questions
- Group Project

Assessment
Students’ learning should be assessed on Bloom’s taxonomy model, as well as on their class participation, enthusiasm, inquiry, and team work. At the end of the lesson, students will be able to:

- start a small basic program.
- identify the various components of the main screen.
- write a simple program and explain how to save, execute, and open a program.
- explain the rules of small basic programming.
- define constants and variables.
- differentiate between the two types of constants.
- list the rules for naming variables.
- differentiate between numeric and string variables.
- explain what an assignment statement is.
- define the terms: operators and expression.
- describe the types of operators with examples.
- define concatenation.
- write comments in a program.
- define an object, a property, and a method.
- differentiate between the write () and writeln () methods.
- explain the textwindow object in detail.
- differentiate between read () and readnumber () methods.

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.
• describe math library functions with examples.
• describe the different formats of the if statement.
• differentiate between if…then…else and if…then…elseif statements.
• demonstrate the use of the If statement taking daily life examples.

Conclusion (10 minutes)

Encourage students to give you a recap of the main points they have learnt in the lesson. Have a discussion on any one on the topics mentioned in the teacher’s notes, given at the end of the chapter.

Chapter 7 The Internet as a Post Office

Time for each lesson: 40 minutes

Resources: a laptop, a projector (if available), computer lab, Internet, any email service e.g. Gmail, Yahoo mail, Hotmail, etc.

Introduction (5 minutes)

Start off the lesson by asking students what activities they carry out on the Internet. Introduce to them to the concept of Internet Service Providers (ISP). To help them better understand this concept, you may ask them which internet service provider they use at home while naming a few like PTCL, Storm Fibre etc. Also explain the concept of IP addresses, URL and domain names.

Explanation (25 minutes)

Explain to students the concept of emails and how they have made life easier. You may compare email services with traditional post letters to further elaborate the advantages of emails.

Next you may take your students to the computer lab and demonstrate how to create an email address. Ask them to create their own email addresses and talk them through the process of sending emails to their friends. Make sure that they’re given ample time for this activity. You can also ask them to perform the Practice time questions individually or in groups of 3. All of this will allow students to practice what they’ve learnt during the lesson. You can assign any of the following tasks for classwork.

• Exercises
• In the Lab
• Application Based Questions
• Group Project

Assessment

Students’ learning should be assessed on Bloom’s taxonomy model, as well as on their class participation, enthusiasm, inquiry, and team work. At the end of the lesson, students will be able to:

• define the following terms:
  o ISP
  o Modem
  o Web Page
  o Web Browser

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.
• differentiate between number addressing and letter addressing systems with examples.
• list the advantages of email.
• explain the parts of an email address.
• list the various features of an email service.
• demonstrate how to open an email account.
• demonstrate how to compose and send emails.
• demonstrate how to create signatures.
• explain why it is important to sign out properly.
• explain what a search engine is.
• demonstrate how to use a search engine to find information.
• explain how the internet is a great tool for education.
• search for people on the Internet.

Conclusion (10 minutes)

Encourage students to give you a recap of the main points they have learnt in the lesson. Have a discussion on any one on the topics mentioned in the teacher’s notes, given at the end of the chapter.

Chapter 8 Introduction to Flash CS3

Time for each lesson: 40 minutes

Resources: a laptop, a projector, Flash CS3, computer lab, a short video containing any animations, saved on your laptop

Introduction (5 minutes)

Start the lesson off by showing students a short animated video. You can then initiate a discussion by asking students how they think the video was made. And from there, introduce them to the chapter explaining that Flash CS3 is one such software that allows users to create attractive web pages by combining audio, images, videos, and animations.

Explanation (25 minutes)

In this lesson, you will only need to introduce your students to the various properties and terminologies of Flash CS3. You may take them to the computer lab and show them the software. Explain in detail, what a tool panel is and all the different tools that it contains and their functions. Similarly, elaborate on the different selection tools and where each one of them is used. And finally, explain to them the purpose of the Property Inspector and what it does.

You can also ask students to perform the Group Project and some other relevant questions from ‘In The
Lab’ either individually or in groups of 3. All of this will allow them to retain what they have learnt during the lesson.

You can assign any of the following tasks for classwork.

• Exercises
• In the Lab
• Application Based Questions
• Group Project

Assessment

Students’ learning should be assessed on Bloom’s taxonomy model, as well as on their class participation, enthusiasm, inquiry, and team work. At the end of the lesson, students will be able to:

• explain the use of the flash software.
• demonstrate how to start flash CS3.
• explain the components of the flash window.
• explain different areas of the tools panel.
• explain the importance of the property inspector.
• explain the use of rulers.
• demonstrate how to create a new flash document.
• demonstrate how to set document properties.
• demonstrate how to save and open a file.
• differentiate between merge drawing mode and object drawing mode in flash.
• demonstrate how to use the different selection tools: arrow tool, lasso tool.

Conclusion (10 minutes)

Encourage students to give you a recap of the main points they have learnt in the lesson. Have a discussion on any one on the topics mentioned in the teacher’s notes, given at the end of the chapter.

Chapter 9 Drawing Tools in Flash CS3

Time for each lesson: 40 minutes

Resources: a laptop, a projector, Flash CS3, computer lab, a short video containing any animations, saved on your laptop

Introduction (5 minutes)

You may start off the lesson by asking students to briefly recap all the important points of the previous lesson. This will help ensure that students remain engaged in this discussion. Encourage them to share any other information that they have come across regarding Flash CS3.

Explanation (25 minutes)

In this lesson, you will have to focus on the drawing tools of Flash CS3. It is important that students practice all of the tools mentioned in the chapter and do not have any confusion regarding tool names.

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.
and functions. You may take them to the computer lab and show them the tools and their workings before asking them to practice it on their own.

You can ask students to perform the Practice Time questions to ensure that they practice what they’ve learnt. Along with this, practicing the Group Project and some other relevant questions from ‘In The Lab’ either individually or in groups of 3 will also help them retain what they have learnt during the lesson.

You can assign any of the following tasks for classwork.
- Exercises
- In the Lab
- Application Based Questions
- Group Project

Assessment

Students’ learning should be assessed on Bloom’s taxonomy model, as well as on their class participation, enthusiasm, inquiry, and teamwork. At the end of the lesson, students will be able to:
- demonstrate the use of the line tool, rectangle tool, rectangle primitive tool, oval tool, oval primitive tool, polystar tool, pencil tool, brush tool, paint bucket tool, ink bottle tool, eraser tool.
- differentiate between the rectangle tool and the primitive rectangle tool.
- differentiate between the oval tool and the primitive oval tool.
- create a new gradient.
- demonstrate how to use the ink bottle tool and the eraser tool.
- demonstrate how to reshape lines using the Arrow Tool.

Conclusion (10 minutes)

Encourage students to give you a recap of the main points they have learnt in the lesson. Have a discussion on any one on the topics mentioned in the teacher’s notes, given at the end of the chapter.

Chapter 10 Creating Animations in Flash CS3

Time for each lesson: 40 minutes

Resources: a laptop, a projector, Flash CS3, computer lab, a short video containing any animations (saved on your laptop)

Introduction (5 minutes)

You may start off the lesson by asking students to briefly recap all the important points of both the previous lessons (Chapters 8 and 9). Make sure they remain engaged in the discussion. Encourage them to share any other information that they have come across regarding Flash CS3.

Explanation (25 minutes)

For this lesson, you will again have to take your students to the computer lab. They will need proper practice of all the new functions introduced in this chapter including symbols, timeline, and frames. Ensure that students are able to differentiate between motion tweening and shape tweening.

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.
You can ask them to perform the Practice Time questions to ensure that they practice what they’ve learnt. Along with this, practicing the Group Project and some other relevant questions from ‘In The Lab’ either individually or in groups of 3 will also help them retain what they’ve learnt during the lesson.

You can assign any of the following tasks for classwork.
- Exercises
- In the Lab
- Application Based Questions
- Group Project

**Assessment**

Students’ learning should be assessed on Bloom’s taxonomy model, as well as on their class participation, enthusiasm, inquiry, and team work. At the end of the lesson, students will be able to:
- explain the components of the timeline window.
- differentiate between frames and keyframes.
- insert frames and keyframes.
- delete a frame.
- create frame-by-frame animations.
- create a motion tween.
- create a shape tween.

**Conclusion (10 minutes)**

Encourage students to give you a recap of the main points they have learnt in the lesson. Have a discussion on any one on the topics mentioned in the teacher’s notes, given at the end of the chapter.

* The lesson plan for each chapter has a flexible structure. It can be split up into daily lesson plans to suit various classroom needs.
ANSWER KEY TO THE COURSEBOOK

- The complete Answer Key to the Coursebook Exercises has been given here including that for the In the Lab questions, Worksheets/Assessment papers, Group Projects, Revision Questions, and the Cyber Olympiad Questions.

- These are only suggested answers, and variations are possible especially for the open-ended questions, such as the descriptive questions, and those of In the Lab. Teachers may use their discretion while checking the answers provided by the students, and give them marks based on conceptual accuracy and conceptual clarity.

- Teachers should consider the following, while conducting the Group Project activity:
  i. Groups should not be larger than five members; pair work obviously means two people working together; it is always a good idea to make groups of mixed ability.
  ii. Be very clear in your expectations from the group, this means telling them clearly what the assignment is about and what you expect to be submitted.
  iii. Make it clear to the students that part of their marks will depend on how well they work with each other and that you expect all of them to be involved in the project.
  iv. Get the students to select their own group leader; if you see that a group is reluctant to do so, you could assign one; also remind the students that they need to listen to the group leader.
  v. Let the group leader divide the tasks that need to be accomplished.
  vi. As a teacher, your role should be to observe what each group is doing, how well they are collaborating with each other and offer advice if needed; the focus should be to encourage the students to work without too much input from the teacher.
Chapter 1 The Computer System

   d. i. Barcode      e. ii. Bank cheques

DESCRIPTIVE TYPE QUESTIONS

1. a. i. Magnetic Ink Character Recognition  ii. Optical Mark Reader

b. A program is a sequence of step-by-step instructions to perform a particular task.

c. An operating system is the master control program that runs the computer. It controls the flow of signals from the central processing unit to the various parts of a computer. Some popular operating systems are Windows 7 and iOS.

d. Assembly language is a computer language that uses words made with letters of the English alphabet. Each instruction to the computer is written using a letter combination.

Machine language is the language that the computer understands and can execute directly without translation. It is written in the form of a long string of 0s and 1s.

e. A compiler is a program that translates a high-level computer language program into machine language program. The compiler first reads the whole program and then at one go translates it into machine language. It reports the program errors to the user along with the line numbers on which the error has occurred. The translated program called the object program is saved permanently for future use.

An interpreter is a program that translates one statement of a high-level language program into machine code and executes it. It then does the same for the next statement and proceeds in this way until all the statements in the program have been translated and executed. An interpreter is a smaller program than a compiler. The object code produced by the interpreter is not saved. If the same instruction is needed later, the process will be repeated.

f. An LCD projector shows the output from a computer on a large screen. It is commonly used for displaying presentations during meetings and conferences.

g. The answer should include the following aspects:
   • A brief discussion on the reduction in size over time
   • The technological advances which have led to the making of smaller more portable computers which are just as powerful, if not more, than the earlier ones.
   • Increased processing speeds, storage capacity has made it possible for computers to be used in all walks of life, examples could include using laptops for office work such as making presentations, online shopping, smart phones to listen to music, play games, send and receive emails, e-readers such as Kindle for reading books online.
   • Now computers are a part of daily lives, examples should include mention of personal computers, laptops, palm tops
   • Smart cards hold a great deal of personal information about an individual. Examine the hazards of having so much information in one place?

h. There is no doubt that smart cards have made life a lot easier. By holding a great deal of information, smart cards have made all aspects of life easier to cope with by putting all of your personal information on a single chip. But the use of smart cards is not without its dangers. A smart card contains much of your personal information and if stolen it can be used to access personal details such as your personal identity number or credit card number and then used to get financial advantage or commit some fraud; this is what is called identity theft and can cause the actual owner of the card a lot of trouble. Or worse
yet, they could commit another crime and leave your card there, and when authorities find it, you are the one who is liable to get into trouble.

i. It is not important what shapes the students use. Their answer should exhibit some level of comprehension.

The program should ask the user to input a set of marks for different subjects and then add them up and display the output. Below is an example of a program asking for two marks; students could show more.

```
Begin Program

Display on screen: Please enter marks for Mathematics.

User enters marks

Display on screen: Please enter marks for English.

Add marks

Display marks
```

**APPLICATION-BASED QUESTIONS**

a. i. A barcode reader is being used to scan a barcode.
   ii. Barcode reader
   iii. Biscuit packet, clothes

b. i. The sheet shown is called an OMR sheet.
   ii. An OMR (Optical Mark Reader).
   iii. These types of sheets are generally used for answer sheets of exams that have multiple choice questions. The boxes or circles in the sheet can be filled with a dark pencil or ink.
c. | Hardware   | Software |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Barcode reader</td>
<td>compiler</td>
</tr>
<tr>
<td>Card reader</td>
<td>driver</td>
</tr>
<tr>
<td>Plotters</td>
<td>Windows</td>
</tr>
</tbody>
</table>

d. i. Windows 7 is a system software and Quick Heal is an application software.
ii. When the computer is switched ON, the operating system is first loaded onto the memory.

**IN THE LAB**

1. Students should be encouraged to find out the operating system installed on their computer. These might be Windows7, Windows8, etc. Other operating systems are Windows NT, Android etc.

2. **List of Application Software**

   **List of Utility Programs**
   - Antivirus software—Quick Heal, Screen savers, Wallpapers, Backup Software, and Disk Cleaner.

3. Students should be encouraged to search for images and information on different input and output devices in newspapers, magazines, and on the Internet. They can collect these pictures and create a chart.

4. Antivirus software installed in my computer—Quick Heal.
   - Examples of antivirus software—McAfee, Norton, Kaspersky, Avast, Avira.

**GROUP PROJECT**

1. The hardware and software components for making standardised paper are given below.
   i. Optical mark reader—to read the marks made by the students
   ii. CPU—to store the scanned document
   iii. Monitor—to see the results on the screen
   iv. Printer—to print the results

   The components required for reading a credit/debit card are:
   - Smart card reader—to read the card and see when the Rs 10,000 limit has been crossed
   - Application software which can read the smart card

   The following hardware and software components are required to setup a computer system.
   - Monitor
   - Keyboard
   - CPU
   - Mouse
   - Printer
   - Cables
   - Windows software

   Note: Students can include other input and output devices. What we are looking for is whether students can identity various hardware/software available for different tasks as described in the book.
Chapter 2  Formatting Data in Excel 2013

OBJECTIVE TYPE QUESTIONS

1. a. iv. Left    b. iv. all of these    c. ii. Wrap Text
d. iv. All of these e. ii. 54,612.000

DESCRIPTIVE TYPE QUESTIONS

1. a. **Wrap Text**: You can make the text wrap within the same cell. The data is confined to the cell but is displayed in multiple lines.
    - **Merge & Centre**: You can merge adjacent cells into one large cell. The text will be centre-aligned in the single merged cell.
b. **Number** group of the HOME tab shows the various formatting type options for numbers in the Number Format drop down list. To add the Rupee symbol do the following:
   i. Click the arrow next to **Accounting Number Format** and select **More Accounting Formats**. The Format Cells dialog box appears.
   ii. Select the **Symbol** as **PKR English (UK)** and click **OK**. The Rupee symbol appears before the number in cell.
c. Select the cells A1:E5 and click the arrow next to **Fill Color** to choose a colour. The colour will be set as the background of the selected cells.
d. The buttons in the lower row of the Number group of the HOME tab are:
   - Accounting Number format, Percent Style, Comma Style, Increase Decimal, and Decrease Decimal.
e. To format the data to 250:
   i. Type the number in the cell. Select the cell.
   ii. Click the drop down menu arrow of the **Orientation** button in the Alignment group on the HOME tab.
   iii. The drop down menu appears.
   iv. Click **Format Cell Alignment** option.
   v. The Format Cells dialog box appears with the Alignment tab selected.
   vi. Under **Orientation**, using the mouse, drag the pointer to 25° angle.
   vii. The text in the selected cell will appear at this angle.
f. Formatting allows the user to change the way the content of a cell appears in Excel but not change the exact cell value. Excel allows the user to format both text and numbers. This is important because it allows for differentiation between different types of data. The user can highlight the important parts of the worksheet using background colours, different styling of font, or increasing the font size, or even using different fonts. In the same way; since Excel was primarily created to deal with large calculations; number formatting provides the user with a selection of options to make the Excel sheet more presentable and useful. For example, the user can assign the number of decimal places required when dealing with large numbers. The user can also access percentages, scientific notations, fractions, and give symbols for different currencies, etc. All this allows the finished worksheet to look more presentable and easier to understand.

So the advantages derived from the formatting options include ease of readability, better organisation, a more professional look, and a better understanding of large and complex numerical data.
g. A student might choose to use font formatting because it allows for more creativity and customisation, i.e. applying only those formatting commands which they really want. At the end of the day, though, they will only be formatting fonts which is just a small part of the formatting tools available.

The students who choose cell styling are more correct, as not only does it save time in formatting the contents of a cell, the fact that it deals with all aspects of formatting such as font, alignment, type of numbers to use, type of border, cell fill, etc., makes it a more complete solution. Also, Excel allows the user to define their cell style.

h. Presentations will vary. What you should look for is an application of most of the commands that were taught in the chapter. Check to see if the student has used:
   a. Font formatting (size, bold, italic, underline, colour, type, alignment)
   b. Cell borders and colours
   c. Number formatting

### APPLICATION-BASED QUESTIONS

a. Type the text as shown in the figure. Click the HOME tab and do the following:

i. Select cells A1:D1 and do the following:
   - In the Alignment group, click the Centre button.
   - In the Font group, click the Bold button. Click the down-arrow of the Underline button and select the Double Underline option. Click the down-arrow of the Fill Color and select yellow colour from the menu.

ii. Select cells A2:A5. Press the Ctrl key and select cells C2:D5. Click the Centre button in the Alignment group.

iii. Select the cells B2:B5. In the Font group, click the Italics button.

iv. Select the cells A1:D5. Click the Borders drop down menu arrow of the Font group. Select All Borders from the menu.

b. i. A2:C2 - Orientation
   ii. Wrap Text and Centre
      It can be applied manually by clicking Alt + Enter key.

c. i. B3:E3 - Horizontal Centre Alignment
    A4:A6 - Horizontal Left Alignment
   ii. Accounting formats

d. i. Click the HOME tab. In the Font group, click the drop down menu arrow of Fill Color button. The drop down menu appears. Select the pink colour.
   Click the HOME tab. In the Font group, click the drop down menu arrow of Borders button. A drop down menu appears. Select the blue colour from the Line Color sub menu.
   ii. Select the text and in the Font group on the HOME tab, click the Subscript button.

### IN THE LAB

1. Type the text as shown in the figure. Click the HOME tab and do the following:

a. Select cells A1:C1. In the Alignment group, click Merge & Centre. In the Font group, click Bold.

b. Select cells A2:C2. Click Centre in the Alignment group, and Bold in the Font group. Similarly, select cells B3:B18 and click Centre in the Alignment group.

c. Select the cells A3:C18. Click the drop down menu arrow of Fill Color. Select the green colour from the menu.
d. Select the cells A1:C18. Click Borders drop down menu arrow in the Font group. Select All Borders from the menu.

2. Type the text as shown in the figure. Click the HOME tab and do the following:
   a. Select cells A1:C1. In the Alignment group, click Merge & Centre. In the Font group, click Bold.
   b. Select cells A2:C2. In the Alignment group, click Wrap Text and Centre. In the Font group click Bold.
   c. Select cells A3:A10. In the Font group, click Italics.
   d. Select cells B3:C10. In the Alignment group, click Centre.
   e. Select cells A1:C10. In the Font group, click the drop down menu arrow of the Borders button and select All Borders from the menu that appears.

3. Type the text as shown in the figure. Click HOME tab and do the following:
   a. Select cells A1:D1. In the Alignment group, click the Merge & Centre.
   b. Select cells A2:D2. In the Alignment group, click Centre.
   c. Select cells A1:D2. In the Font group, click Bold button.
   e. Select cells A1:D6. In the Font group, set the Font to Verdana and Font Size to 12. Click the drop down menu arrow of the Borders button and select All Borders from the menu that appears.

4. Type the text as shown in the figure. The numeric data is entered without decimal point, comma, zero after the decimal point, and currency symbol. Click the HOME tab and do the following:
   a. Select cells A1:E1. In the Alignment group, click Merge & Centre.
   b. Select cells A2:E2. In the Alignment group, click Centre.
   c. Select cells A1:E2. In the Font group, click Bold. Click the drop down arrow of Fill Color. Select the desired colour from the menu that appears.
   e. Select cells A3:E7. In the Font group click the Fill Color drop down menu arrow and select the desired colour.
   f. Select the cells C3:E7. Select Accounting format in Number group. Select Symbol as English. Set Decimal places: to 2. Use the Comma Style button to set comma as thousands separator.
   g. Select cells A1:E7. In the Font group, set the Font to Tahoma and Font Size to 12. Click the drop down menu arrow of the Borders button and select All Borders from the menu that appears.

GROUP PROJECT

Begin with dividing the class into groups. It is advisable to create the groups in such a way that all groups consist of students with different capabilities. There should be no more than five students in a group. Ask all groups to select their leaders, who should then assign each group member a specific task in relation to the worksheet.

In order to facilitate the process, provide the students with a mark sheet which will give them more time to focus on the practical work.

Clearly define what you will be looking for in the final submissions. This should include the ability to apply font formatting commands, cell styling commands, colour manipulation, and borders.

The final submission should include the names of the group members and the tasks assigned to them.
Chapter 3 Advanced Features of Excel 2013

OBJECTIVE TYPE QUESTIONS

1. a. ii. Flash Fill  
   b. i. Filter is applied  
   c. iii. both i and ii  
   d. iii. Styles  
   e. iv. +

DESCRIPTIVE TYPE QUESTIONS

1. a. You can add a custom list to Excel 2013 by importing a list of items through the following steps:
   i. On the worksheet, type the data and select the list.
   ii. Click the File tab, and then click Options. The Excel Options dialog box appears.
   iii. In dialog box, click Advanced and then under General, click the Edit Custom Lists button.
   iv. The Custom Lists dialog box appears. Verify that the cell reference of the list of items that you selected
       gets filled in the Import list from cells text box, and then click Import. The entire list gets added to
       the List entries and Custom lists boxes.
   v. Click OK on both the dialog boxes.

b. Custom filtering can be applied in the following manner:
   i. Point to Number Filters in the AutoFilter drop down menu of the column Marks. A submenu
       appears. Choose Greater Than (>).
   ii. Click Custom Filter. This will open the Custom AutoFilter dialog box.
   iii. To display only those rows where the data is greater than 500, fill in the value in the dialog box and
       click OK. The filtered rows that satisfy the condition will be displayed in the worksheet.

c. The students should be able to demonstrate how Excel allows users to deal with large amounts of data.
   Actions like copy/pasting or re-typing data over and over again are eliminated through the Autofill
   command. The Autofill command provides users with the option to define what needs to be filled in
   and then apply it to a large number of cells. This way a range of cells can automatically be filled in with
   a series of data. This reduces the chance of error and also speeds up the work. Similarly, the Flash Fill
   command is also very useful in that it uses built in logic to complete cell entries, thereby saving the user
   the time to do so. For example, if three cells have first, middle, and third names in them and the user
   has to type the full name in the fourth cell, using Flash Fill means it only has to be typed it the first time.
   After that the software will suggest the full name for all other entries using logic.

d. The students should be able to identify clearly the difference between the two tools–sorting (arranging
   data in a specific order) and filtering (blocking out data that you do not want to see). In this case, filtering
   would be the best option because Zaid can apply the filter to the column containing the last names and
   then filter out the ones that are not required. This would leave a list of only those people with the same
   last name, e.g. Haroon, making it easier to find the customer.

e. It would be best if this question is assigned during practical work. The students should be given enough
   time to complete the work and then the teacher can go around and check if the three requirements have
   been met. For (a) the sort command should have been used correctly; (b) will require filtering and then
   applying the colour red; (c) the student should apply the filter command using the text filter begins with.
   See the screen shots below:
Screen two:

APPLICATION-BASED QUESTIONS

a. i. Select the cell B2 and click on the Format Painter in the Clipboard group on the HOME tab. Then click and drag the mouse pointer over the cells C2:E2.

ii. D4-10    E4-14

b. i. Filter
ii. 1001, 1003, 1006
iii. Click the HOME tab. In the Editing group, click Sort & Filter and select Clear.

c. i. Conditional Formatting
   ii. HOME tab, Styles group
   iii. To clear conditional formatting, click Clear Rules in the Conditional Formatting drop down menu. A submenu appears with two options: Clear Rules from Selected Cells and Clear Rules from Entire Sheet. Select your preferred option.
   iv. Select StudentName column and on the HOME tab, in the Editing group click the Sort & Filter button. The drop down list appears. Click Sort Largest to Smallest.
   v. Select Fees column and on the HOME tab, in the Editing group click the Sort & Filter button. In the drop down list that appears, click Sort Smallest to Largest.

IN THE LAB

1. a. To perform the conditional formatting:
   i. Select the cell range C2:E6.
   ii. Now on the HOME tab in the Styles group click the Conditional Formatting button and a drop down menu appears.
   iii. From the menu select Highlight Cell Rules and from the submenu select Greater Than…. A dialog box appears, enter 10 in the box and select the colour by clicking Custom Format from the submenu. A dialog box appears. Under its Fill tab select dark red colour.
   iv. Click OK.
   All the cells greater than 10 will be filled with dark red background.
   b. To fill the cells lower than 8 with dark blue background, the steps will remain the same as above, but replace step iii with the following:
   From the menu select Highlight Cell Rules and from the submenu select Less Than…. A dialog box appears, enter 8 in the box and select the colour by clicking Custom Format from the submenu. A dialog box appears, under its Fill tab select dark blue colour.
   All the cells less than 8 will be filled with dark blue background.

2. a. Select the DepartmentNo column and click the Sort and Filter button on the HOME tab in the Editing group. From the drop down list select Sort A to Z.
   b. Select the ProjectNo column and click the Sort and Filter button on the HOME tab in the Editing group. From the drop down list select Sort Z to A.
   c. Select the cell range A1:D8 and click the Sort and Filter button on the HOME tab in the Editing group. From the drop down list select Custom Sort…. In the dialog box that opens select DepartmentNo in the Sort by field and A to Z in the Order field. Now click Add Level button to add another sorting criterion on the selection. Select ProjectNo in the Then by field and A to Z in the Order field.

3. On the HOME tab in the Editing group click the Sort & Filter button and from the drop down menu select
Filters. Filter handles appear next to column headings.

a. Click the handle next to **Height in Centimeters** and from the drop down menu select **Number Filters**, from the submenu select **Greater Than** .... Enter 155 in the dialog box.

b. Click the handle next to **Weight in Kilograms** and from the drop down menu select **Number Filters**, from the submenu select **Less Than** .... Enter 60 in the dialog box.

c. Click the handle next to **BirthDate** and from the drop down menu select **Text Filters**, from the submenu select **Contains** .... Enter 10 in the dialog box.

d. Click the handle next to ‘**Student Name**’ and from the drop down menu select **Text Filters**, from the submenu select **Begins With** .... Enter S in the dialog box.

4. Enter Shazia.khurram@alsan.org in cell C2. In cell C3, start typing the First Name. As you do, the Flash Fill logic suggests a series of values to fill in cells C3:C6. Press ENTER to accept the suggestions.

---

### GROUP PROJECT

Divide the class into an equal number of groups and ask each group to select a group leader. The group leader can assign different tasks to the group members but ensure that all the students demonstrate adequate skills while creating the Excel worksheet.

---

### Chapter 4  Introducing Publisher 2013

#### OBJECTIVE TYPE QUESTIONS

1. a. iv. both i. and iii.  
   b. iv. both i. and ii.  
   c. ii. .pdf  
   d. ii. objects  
   e. ii. Drop Cap

#### DESCRIPTIVE TYPE QUESTIONS

1. a. The **Page navigation pane** allows you to view and work with all the pages in your publication. You can view the page thumbnails and add, delete, rearrange, and duplicate pages in this pane.

   b. The two tabs that appear when you select a text box are: **DRAWING TOOLS** and **TEXT BOX TOOLS** with their respective **FORMAT** tabs.

   c. **Typography** refers to the style and appearance of the character in a piece of text. The typography commands are found in the **typography** group on the **FORMAT** tab under **TEXT BOX TOOLS**.

   d. Select the text box. Click the **FORMAT** tab under the **DRAWING TOOLS** tab on the ribbon. For changing the colour of the text box, click the Shape Fill option, in the **ShapeStyles** group, and select the background colour to fill the text box.
e. Some fonts have decorative elements in their character set, mostly in the form of patterned serifs. The **Swash** option enables these elements for the fonts.

**Ligatures**, on the other hand, are connections between characters that seem to create a single character out of one or more characters. This makes the text appear more readable.

f. Students should be able to explain the similarities and differences between the interfaces of MS Publisher and MS Word. Below is a table which highlights some:

<table>
<thead>
<tr>
<th>Similarities</th>
<th>Differences</th>
</tr>
</thead>
<tbody>
<tr>
<td>Both allow choosing font type, colour, and size.</td>
<td>MS Word is primarily used for text.</td>
</tr>
<tr>
<td>Both allow formatting text such as the use of italics, bold, underline, and justify.</td>
<td>MS Publisher allows extensive use of images.</td>
</tr>
<tr>
<td>Both allow for text alignment—justify, left align, right align.</td>
<td>A blank document in MS Word is just a blank white space, while in MS Publisher it shows a blank white space with a blue boundary and allows you to work only within that boundary.</td>
</tr>
<tr>
<td>Commands for formatting text are similar in both software.</td>
<td>Rulers open automatically when opening an MS Publisher document. This isn’t the case in MS Word.</td>
</tr>
<tr>
<td>The left hand side of an MS Publisher document shows the pages that the document contains, so you know how big your publication is—this is not the case in MS Word.</td>
<td>To write text in MS Publisher, you have to draw a text box, while in MS Word you can start typing right away.</td>
</tr>
</tbody>
</table>

g. Students should describe that MS Publisher is a software which has been developed to design various types of documents using a desktop computer and offers many more options and more control in doing so. A complete answer will include examples, such as the fact that MS Publisher has more options for image manipulation. In MS Publisher, the user is able to move images and text around easily which makes designing something like a greeting card easier. A student who opts for MS Word is not necessarily wrong but the better software to use is MS Publisher.

h. The designs will vary from student to student. Once the students have designed the front page, the teacher could ask each student to explain which tool they used and for what purpose. Their covers should show creative manipulation of the text, which shows that they have chosen the font, and adjusted the size and colour. Check whether they have used Drop caps, or the swash or ligature features.

### APPLICATION-BASED QUESTIONS

a. i. **Drop Cap**

   ii. To apply the Drop Cap feature, do the following:
   - Select the text.
   - Click the **FORMAT** tab under the TEXT BOX TOOLS box.
   - In the Typography group, click Drop Cap to view the various available styles.
   - Click Custom Drop Cap option at the end of the list to get the Drop Cap dialog box. Change the options in the dialog box that appears and click OK.

b. i. If a text box is not large enough to contain all of the text you want to include, you can use linking to connect text boxes. The text will continue from one text box to the next.

   ii. The steps to connect text boxes are:
   1. Select the text box.
2. Click the FORMAT tab under the TEXT BOX TOOLS tab and in the Linking group, click Create Link.
3. The cursor changes to the link (a pitcher) icon. Click in the text box that you want to link.
4. The text boxes will be linked. Resize the linked box as necessary. Any text that overflows from the original text box will now appear in the connected box.

c. i. .pdf
   ii. To insert the name and telephone number in the card,
   • Click the INSERT tab. Click the Business Information button in the Text group.
   • Select Field Individual name. It is inserted in the publication.
   • Drag the text box to the desired position. Widen the text box so that it can accommodate the telephone number.
   • Repeat the step but this time, select Field Phone/Fax/Email. It is inserted in the same text box.

d. i. Click the FILE tab and select Print option. The Print pane appears on the right with Print preview.
   ii. To print five copies, in Copies of print job box, type 5 and click Print button.

IN THE LAB

1. To make a banner like the one shown follow the steps given below:
   a. Choose a Scheme on the PAGE DESIGN tab. This will define the colour scheme of your borders, background, and other elements of the banner.
   b. Insert a bar from Borders & Accents on the INSERT tab in the Building Blocks group. Duplicate it by clicking on it and pressing Ctrl+C & Ctrl+V. Arrange it at the top & bottom edge of the page.
   c. Select Draw Text Box on the INSERT tab in the Text group for the title, caption, and the school name.
   d. To format the inputted text click the FORMAT tab under TEXT BOX TOOLS and in the Font group change the font colour, size, and family.
   e. Click Online Pictures on the INSERT tab in the Illustrations group. Search for relevant images on Office.com Clip Art, select them, and click Insert.

2. To make an advertisement like the one shown in Publisher:
   a. Choose an A4 landscape page.
   b. Click Online Pictures in the Illustrations group on the Insert tab. Search for mobiles in Office.com Clip Art. Select an image and click Insert. Resize the image to fit at the centre of the document.
   c. To insert the background image and border click the Borders & Accents button in the Building Blocks group on the INSERT tab. From the drop down menu that appears click More Borders and Accents… and choose an image. Duplicate that image by selecting it and pressing Ctrl+C and Ctrl+V. Arrange and resize it and move it to background by right-clicking on it and from the menu select Order -> Send Backward.
   d. To insert the advertisement offer image click the Advertisements button in the Building Blocks group on the INSERT tab. From the drop down menu that appears click More Advertisements… and choose an image. Arrange and resize it. Edit the text on the advertisements by double clicking the sample text on it.
   e. To insert the text click the WordArt button in the Text group on the INSERT tab. Add text in the dialog box that opens and click OK. Arrange and resize it.
   f. Click the Draw Text Box button in the Objects group on the HOME tab. Drag to draw it and add text. Similarly, choose another item from the list and create another advertisement.
3. Following are the steps to create the leaflet shown in Publisher:
   a. Choose an A4 landscape page.
   b. On the INSERT tab in the Text group, click Draw Text Box for the title, school name, date, and description. Add text to the boxes.
   c. On the HOME tab in the Font group apply font, font style, colour, and size to the text in the boxes.
   d. Position the text boxes as shown above. To make the school name appear vertical, select it and click the FORMAT tab under DRAWING TOOLS and in the Arrange group select the Rotate option. Then select Best Fit in the Text group on the FORMAT tab under TEXT BOX TOOLS.
   e. To add pictures click the INSERT tab and in the Illustrations group select Online Pictures. In the dialog box that appears, search in Office.com Clip Art. Add a confetti image to the background by inserting it and selecting Apply to Background ▶ Fill from the context menu.
   f. To insert the border click the Borders & Accents button in the Building Blocks group on the INSERT tab. From the drop down menu that appears click More Borders and Accents… and choose a border. Duplicate it by selecting and pressing Ctrl+C and Ctrl+V. Resize it and arrange it on the borders of the page.

4. Following are the steps to create the Class Pass shown in Publisher:
   a. Choose an A4 landscape page.
   b. On the INSERT tab in the Text group, click Draw Text Box. Draw text boxes for the title, school name, class teacher name, signature, and description.
   c. Add text to the boxes.
   d. On the HOME tab in the Font group apply font, font style, colour, and size to the text in the boxes.
   e. Position the text boxes as shown above.
   f. To insert the border click the Borders & Accents button in the Building Blocks group on the INSERT tab. From the drop down menu that appears choose a border. Resize it and arrange it on the border of the page.

GROUP PROJECT

You might want to divide this exercise into two lessons–one where they work and second–where students explain how they created their card. What you are looking for is a demonstration of the ability to utilise the commands that have been used, as well as if they have been applied correctly. Ask each student what their contribution was and how she/he went about accomplishing it; reward creativity generously, the idea should be to encourage students.
Chapter 5  Graphics in Publisher 2013

OBJECTIVE TYPE QUESTIONS

1. a. iii. PICTURE TOOLS  
b. iv. all of these  
c. ii. Arrange  
d. iii. Wrap Text  
e. i. Picture Border

DESCRIPTIVE TYPE QUESTIONS

1. a. The different sources to insert pictures in your publication are:
   - pictures stored on your computer.
   - Office.com Clip Art, a series of royalty-free pre-defined graphics.
   - Bing image search on the Internet.

b. The steps to swap pictures between a publication page and the scratch area are:
   i. In the scratch area, select the picture you want to swap with the picture in the publication. The selected picture displays the swap icon.
   ii. From the scratch area, drag the swap icon of the picture towards the picture on the publication.
   iii. When the pink boundary is displayed, release the mouse button to swap the pictures.

c. Students should mention shapes, pictures, charts, and building blocks as the graphic options that they can use in MS Publisher. Students also need to demonstrate their ability to utilise these tools. For example, students should be able to explain that editing pictures, (cropping them to suit a particular purpose; giving them a style; or setting them as a background), adds to the visual attractiveness of the presentation. Students should be able to demonstrate how the Shapes tool allows for the insertion of a variety of shapes which can then be coloured, made bigger or smaller to add value to the document. In the same way, the use of charts gives options for representing numerical data in a pictorial fashion. Students should demonstrate their knowledge about Building Blocks, that they are predefined objects available in MS Publisher which allows the user to work with shapes, text, and images. Some templates are available for making advertisements which makes it easier for design purposes.

d. This answer will depend on which book is being used for science. Give your students enough time to look closely at their science text books and identify the different graphic features used to make the cover. For example, the title will use font size, colour, and different types of font graphic features used to make the cover. For example, the title will use font size, colour, and different types of font graphic features; the visual feature might be put in a frame. You are looking for the students’ ability to identify the different graphic features used. Based on the students’ answers, assess whether they have covered all aspects given in the book.

e. Again you are looking for the students’ ability to demonstrate their skills to use different tools. Look for their creativity in what they have created and the difficulty level in terms of application of the tools that have been learned.

APPLICATION-BASED QUESTIONS

a. i. Click Arrange Thumbnails button in Arrange group of FORMAT tab under PICTURE TOOLS.  
ii. CTRL + A

b.
c. Right-click the picture. The shortcut menu appears. Select **Apply to Background** and then **Fill** from the submenu.

d. i. Click **INSERT** tab. Click **Shapes** button in **Illustrations** group. The menu appears. Select the shape. Drag it on the publication.

   ii. Select **FORMAT** tab under **DRAWING TOOLS**. Click **Shape Fill** in **Shapes Styles** group and select red colour. Click **Shape Outline** in **Shapes Styles** group and select blue colour. Bring the mouse to **Weight** option, a submenu appears. Select **More Lines**. The **Format Text Box** dialog box appears. Change the **Width** to 2 pt. Click **OK**.

---

### IN THE LAB

1. Following are the steps to create the above poster in Publisher:
   
   a. Choose an A4 portrait page.

   b. On the **INSERT** tab in the Text group, click Draw Text Box. Draw text boxes for the title, school name, and code of conduct points.

   c. Add text to the boxes.

   d. On the **HOME** tab in the Font group apply font, font style, colour, and size to the text in the boxes.

   e. Position the text boxes as shown above.

   f. Click Online Pictures in the Illustrations group on the **INSERT** tab. Search for frame in Office.com Clip Art. Select a frame and click **Insert**. Resize the image to fit the borders of the document.

      Similarly, search for checkbox in Office.com Clip Art. Select an image and click **Insert**. Resize the image to fit at the beginning of code of conduct points.

   g. To insert a border at the end of the code of conduct points, click the Borders & Accents button in the Building Blocks group on the **INSERT** tab. From the drop down menu that appears choose a border. Resize it and arrange it at the bottom of the page.

2. Following are the steps to create the given poster in Publisher:

   a. Choose an A4 portrait page.
b. On the **INSERT** tab, in the Text group, click Draw Text Boxes. Now add a text box.

c. Add text to the box.

d. On the **HOME** tab in the Font group apply font, font style, colour, and size to the text in the box.

e. Position the text box as shown.

f. To insert the border, click the Borders & Accents button in the Building Blocks group On the **INSERT** tab. From the drop down menu that appears, choose a border. Resize it and arrange it on the border of the page.

g. Click Online Pictures in the Illustrations group on the **INSERT** tab. Search for an appropriate image in Office.com Clip Art. Select it and click Insert. Resize the image.

To make the textbox like a parallelogram, click the text and on the **FORMAT** tab under DRAWING TOOLS, in the Shape Styles group, click the Shape Effects button. From the drop down menu that appears select 3-D Rotation -> Perspective -> Perspective Relaxed Moderately. Change colour of the box outline using the same group.

3. Following are the steps to create the given poster in Publisher:

   a. Choose an A4 portrait page.

   b. On the **INSERT** tab, in the Text group, click Draw Text Boxes. Now add text boxes for the title, school name, date, and description. Add text to the boxes.

   c. On the **HOME** tab in the Font group apply font, font style, colour, and size to the text in the boxes. Position the text boxes as shown above.

   d. To add pictures, on the **INSERT** tab, in the Illustrations group select Online Pictures. In the dialog box that appears, search in Office.com Clip Art. Add relevant images.

   e. To change the background colour click the Background button in the Page Background group on the **PAGE DESIGN** tab and choose the desired colour.

4. Following are the steps to make a 3-sided brochure in Publisher:

   a. Choose a Built-In template and choose Brochure. Select a sample brochure.

   b. Edit the text in the text boxes of the front and back pages.

   c. On the **HOME** tab, in the Font group apply font, font style, colour, and size to the text in the boxes.

   d. To add pictures on the **INSERT** tab and in the Illustrations group select Online Pictures. In the dialog box that appears, search in Office.com Clip Art. Delete the sample images on the template and add the relevant images.
GROUP PROJECT

Students should now be able to add the visual graphics, i.e. use the correct tools and be able to evaluate whether the text and visual gel together. This means checking whether the text and visual images are too big or too small. If there is writing on the visual, then has the student checked whether it is legible or not. Whilst making these checks you will be able to gauge whether the students have been able to demonstrate their ability to use these tools effectively.

Chapter 6 Basics of MS Small Basic

OBJECTIVE TYPE QUESTIONS

1. a. iii. \^  
2. b. i. 16  
3. c. ii. 6  
4. d. ii. ’  
5. e. ii. ReadNumber ( )

DESCRIPTIVE TYPE QUESTIONS

1. a. While working in Small Basic, you should remember the following points:
   • All commands must be spelled correctly. For example, if you type WriteLn instead of WriteLine, an error occurs. A command is also called a keyword.
   • A keyword is a reserved word, meaning it cannot be used as anything else, other than a command. All computer languages have a specific set of keywords. Small Basic has 14 reserved words.
   • Small Basic is not case-sensitive, meaning it does not differentiate between upper and lower case letters. This means WriteLine and writeln are the same. But it is good practice to follow preferred case rules in programming.
   • Small Basic ignores all spaces; however spaces help to make the code readable.

b. The rules for naming variables are:
   i. It should only include letters, numbers, and the underscore character.
   ii. The first character must be a letter.
   iii. It cannot be a reserved word of Small Basic.

c. The two types of variables are: Numeric and String. The Numeric type is further classified as Integer and Floating.

d. To write a comment statement, an apostrophe (’) is used before the text. For example, ‘This is a comment statement

e. The Write( ) puts the pointer on the same line whereas WriteLine( ) moves the pointer to the next line.

f. The hierarchy is:
   i. Parenthesis()
   ii. Multiplication (*) and division (/)
   iii. Addition (+) and subtraction(-)

g. The students should be able to explain that the purpose of writing programs is to evaluate the given input and then perform an action based on the information received. The students should explain that this means that a condition has to be set and when that condition is met some action or outcome should occur. They should also be able to elaborate on the fact that:
• The simplest form of setting a condition in Small Basic is the: If-Then statement—which means if something is true/false, i.e. the condition is met correctly, and then some other action should take place.
• The If-Then-Else conditional statement not only allows for one condition to be met but also specifies what needs to be done if the condition is not met.
• The If-Then-Elseif statement is useful when the user wants one action to be taken if a certain condition is met, otherwise they can check if some other condition is met and therefore take a different action. So it allows you to check and gives more flexibility.

h. i. The students should be able to differentiate between the values of S and A, using a comparison operator.
   ii. (10*4) + 6
       Here simple arithmetic operators are being used–multiply and addition.
   iii. Students should be able to explain that a logical operator is being used because two conditions have to be met before the program can proceed further.

i. This exercise is best divided into two parts. The first part will involve the students collecting data from peers which can be completed in class. Once they have collected at least 10 pieces of information, they can then move on to the next task which involves working in the lab. The program asks for two inputs—the age of the student and if they bring lunch to school. The program could then list the names of just those students under the age of 14. Of course the successful completion of this exercise depends upon how much coding has been completed in the class.

APPLICATION-BASED QUESTIONS

a. i. The quotient of 10/3 is 3 and, the remainder is 1.
    ii. The quotient of 20/7 is 2 and, the remainder is 6.

b. i. This feature is called intellisense. It appears for inserting object names, properties, and methods in the program.
    ii. To add a command in the program using this window, move through the list using the Up/Down arrow keys and make a selection by pressing Enter.

c. i. c    ii. a    iii. d    iv. b.

d. i. 1, 2    ii. TextWindow
    iii. It moves the pointer to the next line.    iv. Write() and WriteLine()

IN THE LAB

1. TextWindow.Write(“Enter the radius of a circle”)
   Radius = TextWindow.ReadNumber( )
   Area = Math.Pi() * Radius * Radius
   Perimeter = 2 * Math.Pi() * Radius
   TextWindow.WriteLine(“Area of a Circle = “ + Area)
   TextWindow.WriteLine(“Perimeter of a Circle = “ + Perimeter)

2. TextWindow.Write(“Enter the Temperature in Fahrenheit”)
   Fahrenheit = TextWindow.ReadNumber( )
   Celsius = Fahrenheit * 9/5 + 32
   TextWindow.WriteLine (“Temperature in Celsius = “ + Celsius)
3. TextWindow.Write("Enter Principal amount ")
   P = TextWindow.ReadNumber( )
TextWindow.Write("Enter Rate of Interest ")
   R = TextWindow.ReadNumber( )
TextWindow.Write("Enter Time in years ")
   T = TextWindow.ReadNumber( )
   S = P * R * T /100
TextWindow.WriteLine ("Simple Interest = " + S )

4. TextWindow.Write("Enter number of days a student is present ")
   P = TextWindow.ReadNumber( )
TextWindow.Write("Enter total number of days in a month ")
   M = TextWindow.ReadNumber( )
Att_Per = P/M * 100
TextWindow.WriteLine ("Percentage of Attendance of a student = " + Att_Per )

5. TextWindow.Write("Enter Purchase Amount ")
   PurAmount = TextWindow.ReadNumber()
   If (PurAmount >= 50000 And PurAmount <= 100000) Then
      Discount = 0.01 * PurAmount
   ElseIf (PurAmount >= 100001 And PurAmount <= 300000) Then
      Discount = 0.015 * PurAmount
   ElseIf (PurAmount >= 300001 And PurAmount <= 500000) Then
      Discount = 0.02 * PurAmount
   ElseIf (PurAmount > 500000) Then
      Discount = 0.025 * PurAmount
   EndIf
   NetAmount = PurAmount - Discount
TextWindow.WriteLine("Discount = " + Discount)
TextWindow.WriteLine("Net Amount = " + NetAmount)

---

**GROUP PROJECT**

The design component of the answer in MS Publisher will draw from students’ previous learning. You should assess whether they are using font and graphic tools appropriately. This can be assessed by the appropriateness of the font being used for headings; e.g. its colour and formatting; whether a visual has been used properly and set apart from text; and if mixed with text, whether the text is legible or not.

<table>
<thead>
<tr>
<th>Similarities</th>
<th>Differences</th>
</tr>
</thead>
<tbody>
<tr>
<td>Made by Microsoft</td>
<td>Small Basic creates Windows programs.</td>
</tr>
<tr>
<td>Evolution of the same language</td>
<td>QBasic cannot create Microsoft Windows programs.</td>
</tr>
<tr>
<td>Easy to learn syntax, which is very similar from one form of Basic to the next</td>
<td>You can share your Small Basic programs with other users even if they do not have Small Basic installed.</td>
</tr>
<tr>
<td></td>
<td>QBasic has to be installed in order to run QBasic programs.</td>
</tr>
<tr>
<td></td>
<td>VB is a Graphical User Interface (GUI) language.</td>
</tr>
<tr>
<td></td>
<td>VB is an object oriented programming language whereas SmallBasic is not.</td>
</tr>
</tbody>
</table>
Chapter 7 The Internet as a Post Office

OBJECTIVE TYPE QUESTIONS

1. a. ii. Uniform Resource Locator
   b. i. Surfing
   c. iv. all of these
   d. ii. @
   e. i. in

DESCRIPTIVE TYPE QUESTIONS

1. a. i military ii network access provider iii Japan- country code for Japan
   b. Number addressing system—In the number addressing system, the URL is a numeric address called the Internet Protocol (IP) address. It is made up of four numbers in the range 0 to 255, joined together by dots. For example, 192.12.148.77
   c. Sent folder—It stores the messages that you have sent.
   Draft folder—It stores messages that you started to write but have not yet sent.
   d. The steps to create a signature for an email account are:
      i. Click the Settings icon at the top-right corner of the Gmail window. From the drop down options, select Settings.
      ii. The Settings window appears. Scroll down to Signature section and type the text to be used as your signature. You can also format the text using the buttons available for text formatting.
      iii. Click Save Changes at the bottom of this page.
   e. The Internet has definitely changed the way we communicate. Here are some ways that the Internet has affected the way communication is carried out today:
      • Earlier, when our parents were young there was no Internet or at least it wasn’t as developed as it is today, and so most people relied on making telephone calls or writing letters on paper and then posting them through the post office. Depending on where the letter was going, it could take months for it to reach its final destination.
      • The advancement in communications technology, especially the Internet, means that now communication can be carried out in a matter of seconds. Whether we are using email, or using applications such as Skype, Twitter, Instagram, or others like them, we are able to communicate with people anywhere in the world instantly.
      • Landlines are hardly ever used anymore, as most smart phones have the ability to use the Internet to communicate, so in many respects a smart mobile phone is no less than a computer.
      • The use of the Internet has made it easier to communicate and means that we can share all important news with each other in an instant. This has brought people closer, despite the distances.
   f. Answers will vary. Students might realise that the Internet has become a repository of very large amounts of data and in doing so it has generally become the first place that people turn to conduct research. Some students might disagree with this notion, stating that if that was the case then no more books would be published or that there would be no need for book libraries. Ask students if they are aware of the fact that research can be carried out from a variety of sources amongst which the Internet is the quickest and most comprehensive source.
   g. Draft a detailed email to your principal requesting him/her to allow limited Internet access to students in the secondary classes.

The answer should include a proper salutation such as Dear Sir or Dear Madam and the body of the email should give reasons why students need to have access to the Internet at school. The reasons for
allowing access could include: ease of doing research; keeping well informed of the latest happenings in the world; exposure to new and different ideas which are applicable to all subjects; and the ability to interact with other similarly aged students to get a world perspective on different issues. The student could also mention in their email that they are requesting limited access, for example, during their weekly library period, so that the school is able to offer safe monitoring to protect the students from misuse. The email should end with a formal thank you note to the principal and have the students’ name.

**APPLICATION-BASED QUESTIONS**

a. Observe the figure and answer the questions  
   i. Email address - alsan.kb6.2013@gmail.com  
   ii. Compose  
   iii. Trash

b.  
   i. Bcc  
   ii. To send a picture as an attachment, click the Attach Files (paper clip) icon in the window. The Choose File to Upload dialog box appears. Locate the file and click Open.
   iii. Yes, he can format the text message. Click the Text Formatting icon to use formatting features like font, font size, bold, italics, alignment, and indentation.

c.  
   i. Email is faster.
   ii. Advantages of email:
      • There is no charge for sending and receiving email messages.
      • We need not be at our computer all the time to receive a message.

d. It is important to close your account properly, especially when you are using a public or shared computer. Signing out prevents misuse of your account by other people who will use the same computer.

**IN THE LAB**

1. The steps to send an email are:  
   a. Connect to the Internet.
   b. Open Internet Explorer.
   c. In the Address bar, type www.gmail.com or the URL of any other email service. The Web page will appear in the browser.
   d. Enter your email ID and password and click Sign In.
   e. Click Compose to create a new message.
   f. The New Message/Compose window appears.
   g. Enter the email addresses of your friends in the To box.
   h. Write a subject for the message.
   i. Type few sentences about the new features of Gmail.
   j. Click the Send button at the bottom to send the message.

2. The steps to send an email with a picture as an attachment are:  
   a. Connect to the Internet.
   b. Open Internet Explorer.
   c. In the Address bar, type www.gmail.com or the URL of any other email service. The Web page will appear in the browser.
d. Enter your email ID and password and click Sign In.
e. Click Compose to create a new message.
f. The New Message/Compose window appears.
g. Enter the email addresses of the five friends you wish to invite to your party in the To box.
h. Write a subject for the message.
i. Type the message.
j. To send the invitation card as an attachment, click the Attach Files (paper clip) icon in the window. The Choose File to Upload dialog box appears. Locate the invitation card and click Open.
k. Click the Send button at the bottom to send the message.

3. The steps to send an email with a PowerPoint presentation as an attachment are:
   a. Connect to the Internet.
   b. Open Internet Explorer.
   c. In the Address bar, type www.google.com or the URL of any other email service. The Web page will appear in the browser.
   d. Enter your email ID and password and click Sign In.
   e. Click Compose to create a new message.
   f. The New Message/Compose window appears.
   g. Enter the email address of your computer science teacher in the To box.
   h. Write a subject for the message.
   i. Type the message.
   j. To send the PowerPoint presentation as an attachment, click the Attach Files (paper clip) icon in the window. The Choose File to Upload dialog box appears. Locate the PowerPoint file and click Open.
   k. Click the Send button at the bottom to send the message.

4. The steps to send an email and the holiday homework file as an attachment are:
   a. Connect to the Internet.
   b. Open Internet Explorer.
   c. In the Address bar, type www.google.com or the URL of any other email service. The Web page will appear in the browser.
   d. Enter your email ID and password and click Sign In.
   e. Click Compose to create a new message.
   f. The New Message/Compose window appears.
   g. Enter the email address of your friend in To box.
   h. Write a subject for the message.
   i. Type the message.
   j. To send the holiday homework file or files as an attachment, click the Attach Files (paper clip) icon in the window. The Choose File to Upload dialog box appears. Locate the file or files and click Open.
   k. Click the Send button at the bottom to send the message.
GROUP PROJECT

Make sure that when you pair the students up you have mixed ability pairs; if your school is coeducational make sure that groups have a healthy mix of boys and girls. This is an important factor in developing social confidence. Answers should include following information:

<table>
<thead>
<tr>
<th>Internet Protocol (IP)</th>
<th>Domain Name System (DNS)</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP stands for Internet Protocol. It is a communications protocol, which is basically the backbone of the Internet.</td>
<td>DNS stands for Domain Name System. It helps to ‘translate’ human readable addresses to IP addresses; this has to be done because computers understand IP addresses and not the fancy names given to the websites.</td>
</tr>
<tr>
<td>Its development began in 1974, led by computer scientists Bob Kahn and Vint Cerf.</td>
<td>The information is stored on Domain Name Servers, which are something like electronic yellow pages.</td>
</tr>
<tr>
<td>There are five classes of IP addresses.</td>
<td>It has been in use since 1985</td>
</tr>
<tr>
<td>IP address is like a mailing address and each computer on the Internet has a unique IP address.</td>
<td>By providing a distributed directory service, it is an essential component of the Internet.</td>
</tr>
<tr>
<td>It is frequently used in conjunction with the Transmission Control Protocol, or TCP. Together they are referred to as TCP/IP.</td>
<td></td>
</tr>
<tr>
<td>IP delivers packets from the host to the destination using the ‘addresses’ found in the headers of data packets.</td>
<td></td>
</tr>
<tr>
<td>All information transferred on IP is in ‘packet’ form.</td>
<td></td>
</tr>
<tr>
<td>IPv4 the dominant version is being used on the Internet.</td>
<td></td>
</tr>
</tbody>
</table>

Chapter 8  Introduction to Flash CS3

OBJECTIVE TYPE QUESTIONS

1. a. i. Zoom In b. ii. 12 c. ii. File
d. i. Property Inspector e. iv. all of these

DESCRIPTIVE TYPE QUESTIONS

1. a. The grid is a system of intersecting horizontal and vertical lines on the stage. The grid is helpful while creating graphics. It helps you to place and align objects at particular positions on the stage.
   
   b. The steps to save a file in Flash CS3 are:
      
      i. Select Save As option of File menu. The Save As dialog box appears.
      ii. Select the drive and folder where you want to save your file.
      iii. Type the filename in the Filename box.
      iv. Click the save button. The file is saved with .fla extension.
c. The steps to open an already saved file in Flash are:
   i. Select Open option from the File menu. The Open dialog box appears.
   ii. Select the drive and the folder.
   iii. Select the file.
   iv. Click Open button.

d. Names of games could include: ‘Angry Birds’, ‘Clash of Clans’, ‘FarmVille’, ‘AdventureQuest’, ‘Machinarium’, ‘Hundreds’, ‘N’, ‘QWOP’ and ‘Solipskie’; these are some of the more popular games developed using Flash CS 3. Answers for the questions about similarities and differences will vary, in terms of what the games are about, and what the purpose of the games are. For example, in ‘Angry Birds’ the players try to save eggs, while in ‘Hundreds’ players have to touch circles ensuring that they don’t overlap, and ‘Machinarium’ is an adventure game. Similarities between the games could include the use of multiple animations, differing shapes and a wide spectrum of colours.

e. | a. Similarities | Differences |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>It allows you to work with different types of graphics in terms of inserting shapes into the document, filling them with colours, magnifying them, adding text to them.</td>
<td>MS Publisher tools are more Text friendly being closer in the way they operate to MS Word rather than Flash CS 3.</td>
</tr>
</tbody>
</table>

The reason for using different software is because the focus of Flash CS 3 is on creating and manipulating different shapes, while MS Publisher allows for considerable text manipulation along with the use of graphics.

f. Here you are looking for the students’ ability to use the appropriate command to open a new document: Select->File->New Document. They then need to assign properties to their document using the Modify -> Document Properties. Next they have to use either the Merge Drawing Mode or Object Drawing Mode to create the shapes required. Marks can be given based on student creativity.

**APPLICATION-BASED QUESTIONS**

a. i. Some tools have a small triangle at the bottom right corner. On clicking it, a pop-up menu appears with more related tools.
   ii. Pen Tool

b. i. Modify menu and Document option
   ii. Dimensions of the Stage 550 px by 400 px
   iii. Frame rate selected for the movie is 12
   iv. The ruler unit selected for the movie is pixels. The default ruler unit is pixels.

c. i. The two options of the Magnifier Tool—Zoom In allows you to view the drawing up close, while Zoom Out pulls you away from the drawing by showing it at lower magnification.
   ii. Stroke color—Black and Fill color—Blue
   iii. Lasso Tool is used to select irregular areas on the Stage.

d. i. Merge Drawing mode was selected.
   ii. He should have selected Object Drawing mode.
IN THE LAB

1. To start Flash, click **Start** ► **All Programs** ► **Adobe Premium Design CS3** ► **Adobe Flash CS3 Professional**.
   a. Familiarise yourself with the Tools panel, Timeline, Stage, and Property inspector.

2. The steps to create a new document are:
   i. Select New from the File menu. The New Document dialog box appears.
   ii. Select Flash File (ActionScript 3.0) in the Type list and click OK.
      a. To change the background colour to yellow, select **Modify** ► **Document**.
      b. To Show or Hide rulers, click **View** ► **Rulers**.
      c. To change the ruler units, select **Modify** ► **Document**.
      d. To Show or hide grid, Click **View** ► **Grid** ► **Show Grid**.

3. a. The steps to open an image in Flash are:
   i. Select Open from the File menu. The Open dialog box appears.
   ii. Select the drive and the folder.
   iii. Select the file.
   iv. Click Open button.

   b. To select different parts of image using the Lasso Tool:
      i. Select the Lasso Tool.
      ii. Drag the cursor on the stage to specify the boundary of the selection.
      iii. End the selection approximately near the point where you started.

4. a. The steps to create a new document are:
   i. Select New from the File menu. The New Document dialog box appears.
   ii. Select Flash File (ActionScript 3.0) in the Type list and click the OK button.

   b. Draw a circle and then draw an overlapping rectangle.
      i. Try to move the rectangle to another position.
         If the portion of the circle gets erased, then Merge Drawing mode is selected otherwise Object Drawing mode is selected.

GROUP PROJECT

Presentations will of course vary. You can decide to divide the number of marks you give based on presentation. This can include the overall look and content of what students have put together as well as the use of fonts and formatting. Good presentations, for example, could include an explanation of how each student went about making their Flash document. Content could also include some historical information about Flash; how it was developed and what the future might be like.

Chapter 9  Drawing Tools in Flash CS3

OBJECTIVE TYPE QUESTIONS

1. a. iv. all of these  b. iii. both i. and ii.  c. i. Oval
   d. ii. circular  e. ii. Shift
DESCRIPTIVE TYPE QUESTIONS

1. a. Two modifiers of the Eraser Tool are Faucet Modifier and Eraser Mode Modifier.

   b. When you draw a rectangle with rounded corners, you first have to specify the radius for the corners and then draw the shape. After drawing the shape, you cannot modify the radius if you used Rectangle Tool. But if you used Primitive Rectangle Tool, then you can modify the radius after drawing the shape.

   c. The steps to create a new gradient are:
      i. Select Window ▶ Color.
      ii. Click the drop down arrow of the Type box and select a gradient style—Linear or Radial.
      iii. Click the colour markers you want to change. The colour palette appears.
      iv. Select a colour. You can also click and shift the colour marker left or right on the gradient bar to adjust the gradient.
      v. To add another colour marker, click below the gradient bar. To remove a colour marker, drag it off the bar.
      vi. You can continue creating the gradient effect by adding colour markers and assigning colours to them.

   d. Students have an opportunity here to either agree or disagree with this statement. In either case the student will need to justify their answer.

      For those who say NO: they may argue that regardless of what software is able to do:
      • the originality that an artist brings using a traditional palette cannot be replaced.
      • the human element of understanding the colours and tones required and the ability to produce them cannot be imitated.
      • a computer is pre-programmed and has limitations.

      For those who say YES: These students may argue:
      • the software has the ability not only match but to do much more than an artist with a traditional palette.
      • the software gives an artist more flexibility through a number of options for manipulating the canvas in terms of shape, size, colour, and so much more.
      • rather than wasting sheets of paper because something goes wrong, the software allows for multiple corrections to be made on screen.
      • using software provides more time for the artist to be truly creative.

   e. Here you are assessing the students’ ability to comprehend why the property inspector is used. Answers could include points such as:
      • To assign different ‘properties’ to the shapes inserted into a flash document.
      • Properties such as colour fill, stroke (thin or thick borders), allow users to change shapes as they require.
      • It is extremely important because without it all documents created in Flash would look very similar indeed!

APPLICATION-BASED QUESTIONS

a. i. Pencil Tool    ii. Straighten modifier
   iii. Smooth modifier   iv. Ink modifier

b. To create a cartoon character Dania can use the following tools:
   i. Paint freely—Pencil Tool  ii. Rectangle Tool  iii. Paint Bucket Tool

c. i. Colour panel  ii. Linear gradient
d. Eraser modifiers she will use are:
   i. Erase lines
   ii. Erase Normal
   iii. Erase fills

e. Here you are assessing the student’s ability to use the commands learned so far and to apply them in making an image. You can also give marks for creativity; you could ask students questions about how they applied a certain colour, or how they cut the shape in a particular way.

## IN THE LAB

1. a. To draw lines using the **Pencil Tool**:
   i. Select the **Pencil** tool.
   ii. In the Property inspector, select stroke colour, line thickness, and style.
   iii. When this tool is selected, its modifier is displayed in the lower area of the Tools panel.
   iv. Clicking on the modifier icon shows three options—**Straighten, Smooth, and Ink**.
   v. In this case select Smooth modifier.
   vi. Click and drag to draw the lines.

   b. To create a new gradient:
      i. Select **Window ▶ Color**. The Colour panel appears.
      ii. Click the drop down arrow of the **Type** box and select a gradient style. You can select Linear or Radial gradient.
      iii. Click the colour markers you want to change. The colour palette appears.
      iv. Select a colour. You can also click and shift the colour marker left or right on the gradient bar to adjust the gradient.
      v. To add another colour marker, click below the gradient bar. To remove a colour marker, drag it off the bar.
      vi. You can continue creating the gradient effect by adding colour markers and assigning colours to them.

   c. To fill colour with the **Paint Bucket Tool**:
      i. Select the Paint Bucket Tool.
      ii. Select the fill colour from the Property Inspector.
      iii. Click the drop down arrow of Gap Size modifier and choose a gap size option to close gap in the shape.
      iv. Click inside the shape for filling it with colour.

2. a. To draw lines using the **Pencil Tool**:
   i. Select the Pencil Tool.
   ii. In the Property inspector, select stroke colour, line thickness, and style.
   iii. When this tool is selected, its modifier is displayed in the lower area of the Tools panel.
   iv. Clicking on the modifier icon shows three options—**Straighten, Smooth, and Ink**.
   v. In this case select the Smooth modifier.
   vi. Click and drag to draw the lines.

   b. To draw the flower shape:
      i. Draw a star shape.
      ii. Click the **Arrow Tool**.
      iii. Make sure that no line is selected. Bring the mouse pointer near a line. A curve appears below the mouse pointer.
      iv. Click and drag to reshape the line and then release the mouse button. Do this for all other lines of the star shape.
c. To create a new gradient:
   i. Select **Window ▶ Color**. The Colour panel appears.
   ii. Click the drop down menu arrow of the **Type** box and select a gradient style. You can select Linear or Radial gradient.
   iii. Click the colour markers you want to change. The colour palette appears.
   iv. Select a colour. You can also click and shift the colour marker left or right on the gradient bar to adjust the gradient.
   v. To add another colour marker, click below the gradient bar. To remove a colour marker, drag it off the bar.
   vi. You can continue creating the gradient effect by adding colour markers and assigning colours to them.

d. To fill colour with the **Paint Bucket** Tool:
   i. Select the **Paint Bucket** Tool.
   ii. Select the fill colour from the Property Inspector.
   iii. Click the drop down menu arrow of Gap Size modifier and choose a gap size option to close gap in the shape.
   iv. Click inside the shape for filling it with colour.

3. a. To draw lines using the **Pencil** Tool:
   i. Select the **Pencil** Tool.
   ii. In the Property inspector, select stroke colour, line thickness, and style.
   iii. When this tool is selected, its modifier is displayed in the lower area of the Tools panel.
   iv. Clicking on the modifier icon shows three options—**Straighten, Smooth, and Ink**.
   v. In this case select the Smooth modifier.
   vi. Click and drag to draw the lines.

b. To create a new gradient:
   i. Select **Window ▶ Color**. The Colour panel appears.
   ii. Click the drop down menu arrow of the **Type** box and select a gradient style. You can select the Linear or Radial gradient.
   iii. Click the colour markers you want to change. The colour palette appears.
   iv. Select a colour. You can also click and shift the colour marker left or right on the gradient bar to adjust the gradient.
   v. To add another colour marker, click below the gradient bar. To remove a colour marker, drag it off the bar.
   vi. You can continue creating the gradient effect by adding colour markers and assigning colours to them.

c. To paint inside the balloons using the **Brush** Tool
   i. Select the **Brush** Tool.
   ii. Select the fill color.
   iii. Click the Brush Mode Modifier from the Tools panel and select a painting mode. You can also select the desired brush shape and size.
   iv. Drag the mouse pointer on the stage to apply a brush stroke.

d. To fill colour with the **Paint Bucket** Tool:
   i. Select the **Paint Bucket** Tool.
   ii. Select the fill colour from the Property Inspector.
iii. Click the drop down menu arrow of the Gap Size modifier and choose a gap size option to close gap in the shape.

iv. Click inside the shape for filling it with colour.

e. To paint colour behind the balloons:

i. Click the Brush Tool.

ii. Select the fill color.

iii. Click the Brush Mode Modifier and select the option Paint Behind.

f. To write text using the Brush Tool:

i. Select the Brush Tool.

ii. Select the fill/gradient color.

iii. Select the desired brush shape and size.

iv. Drag the mouse pointer on the stage to apply a brush stroke.

4. a. To draw lines using the Pencil Tool:

i. Select the Pencil Tool.

ii. In the Property Inspector, select stroke color, line thickness, and style.

iii. When this tool is selected, its modifier is displayed in the lower area of the Tools panel.

iv. Clicking on the modifier icon shows three options—Straighten, Smooth, and Ink.

v. In this case select the Smooth modifier.

vi. Click and drag to draw the lines.

b. To fill colour with the Paint Bucket Tool:

i. Select the Paint Bucket Tool.

ii. Select the fill colour from the Property Inspector.

iii. Click the drop down menu arrow of Gap Size modifier and choose a gap size option to close gap in the shape.

iv. Click inside the shape for filling it with colour.

c. To write text using the Brush Tool:

i. Select the Brush Tool.

ii. Select the fill/gradient color.

iii. Select the desired brush shape and size.

iv. Drag the mouse pointer on the stage to apply a brush stroke. Type a greeting like “Happy Independence Day”.

GROUP PROJECT

Open FL and HTML 5 could be given as examples by students. Open FL is very similar to Flash, while there is a tool which converts Flash into HTML to be used on web browsers. Advertisements will differ but what you are assessing is how well the students have used the commands that they have learned. Creativity should be appreciated. Generally the marking scheme could focus on: presentation of work, research skills, content, and creativity.
## Chapter 10  Creating Animations in Flash CS3

### OBJECTIVE TYPE QUESTIONS

1. a. i. motion  
   b. ii. small  
   c. iii. Library  
   d. i. symbol  
   e. ii. Timeline

### DESCRIPTIVE TYPE QUESTIONS

1. a. The black dots in the Timeline indicate a keyframe.  
   The keyboard shortcut to insert a frame is F5 and keyframe is F6.

   b. The steps to delete frames 5 to 10 are:
   i. Select the frames 5 to 10.
   ii. Right-click and select Remove Frames from the shortcut menu.

   c. We can convert the Robot shape to a man using Shape tweening.

   d. Important points to create motion tween:
   i. Drawing must be converted into symbol.
   ii. Specify the initial and the final positions.

   e. Regardless of whether the student says yes or no on how user friendly the software is, they should be able to justify their choice by giving logical explanations for it. For example, if they say it is not user friendly, they could say that the tool bar is too confusing to use with strange symbols and names such as the lasso tool. Others could disagree and say that it is as easy to use as any other software.

   f. You will be evaluating students on their understanding and usage of the commands that they have learned so far in the textbook. The more commands they use correctly is indicative of the fact that they have the developed the skills needed to do so, but it is also helpful to test student knowledge by asking a few oral questions based on what they have created. Give marks for creativity and be generous so that it encourages students to gain confidence and experiment more with using the software.

### APPLICATION-BASED QUESTIONS

a. i. A Timeline is shown in the given figure.  
   ii. Frame 1 is the keyframe.  
   iii. The frame rate is 12 fps.

b. i. Shape tweening.  
   ii. Elapsed time—4.0 s  
   iii. Current frame—21s

c. i. The keyboard shortcut to get the Convert to Symbol dialog box is F8.  
   ii. Graphic  
   iii. Modify menu

d. i. Shape tweening  
   ii. No iii. Green colour

### IN THE LAB

1. a. Draw a scenery using different tools.

   b. To convert an existing drawing into a symbol:
i. Select the Arrow Tool.
ii. Select the drawing on the stage.
iii. Select Modify ▶ Convert to Symbol. The Convert to Symbol dialog box appears.
   1. Type a name for the symbol.
   2. Choose Graphic as the Type of Symbol.
   3. Click OK. The symbol gets added to the Library panel.

c. To insert an instance of the symbol:
   i. Select Window ▶ Library to open the Library panel. You will see the symbol you created.
   ii. Click and drag it onto the Stage. This inserts one instance of the symbol.

d. Draw a bird and a tree using different tools. Convert the bird object into a symbol using the above
   process.

e. Copy the tree object and paste it in the right side of the Stage.

f. To apply motion tweening to a symbol:
   i. Select frame 40. Select the bird and move it to the top of the tree on the right side of the Stage.
   ii. Select any frame between 1 and 40. With the cursor in the grey area, right-click and select Create
      Motion Tween from the context menu.
   iii. Notice the change in the Timeline window. A light-purple colour with a solid arrow appears between
      the frames.
   iv. Play the movie. You will see the bird move from the tree at the left corner to the right tree at the right
      corner of the Stage.

2. a. Draw or import a picture of a boat at the top-left corner of the stage in frame 1.

   b. Convert the shape into a symbol. Give the symbol the name boat.

   c. Select frame 40 in the Timeline window and insert a keyframe by pressing F6 or selecting Insert ▶ Timeline
      ▶ Keyframe.

   d. Notice that all the frames from 2 to 39 are now in grey colour. Frame 40 has a grey fill with a black dot,
      indicating that it is a keyframe.

   e. Select frame 40. Select the boat and move it to the top-right corner of the Stage.

   f. Select any frame between 1 and 40. With the cursor in the grey area, right-click and select Create Motion
      Tween from the context menu.

   g. Notice the change in the Timeline window. A light-purple colour with a solid arrow appears between
      the frames.

   h. Play the movie. You will see the boat move from the top-left corner to the top-right corner of the Stage.

3. a. Select the first frame in the Timeline.

   b. Select the Oval Tool. Then select the stroke colour and fill colour.

   c. Draw a Circle shape on the Stage.

   d. Select frame 20 in the Timeline and insert a Blank Keyframe by pressing F7 or by selecting Insert ▶ Timeline ▶ Blank Keyframe.

   e. Draw a Cat shape on the stage. You can also change the stroke color and fill color.

   f. Click on any frame between 1 and 20 in the Timeline. Right-click and select the Create Shape Tween
      option from the context menu.

   g. Select Frame 1 in the Timeline and press Enter to play the movie.
4. a. Draw a star shape on the stage.
   b. Click on the second frame in the Timeline window.
   c. Insert a keyframe by selecting Insert ▶ Timeline ▶ Keyframe or by pressing F6.
   d. Draw another star on the stage.
   e. Add ten more keyframes and draw a star shape at different positions in each frame. You can change the colour of the star in each frame.
   f. To play the movie, Click on the first frame in the Timeline window. Then Select Control ▶ Play.

**GROUP PROJECT**

Make sure that the groups you make have mixed ability of students with a range of abilities. Ask the students to select a group leader who will assign individual tasks and make sure that the work is completed on time. There is a long list of animated characters, TV series, and movies that were made using Flash, so the answers here will vary. Some names that you could come across include: ‘The Simpsons’, ‘The Adventures of Rocky and Bullwinkle’, ‘Danger Mouse’, and ‘Speed Racer: the Next Generation’.

In terms of the video that the students create you are looking for creativity as well as the skills to use appropriate commands.

**ASSESSMENT 1**

**SECTION A (THEORY)**

1. **Who am I?**
   a. E-book reader   b. Smart phone   c. MICR Characters   d. Alignment

2. **Identify what the following figures represent.**
   a. LCD Projector   b. Flatbed plotter   c. OMR Sheet   d. Barcode

3. **Answer the following.**
   a. Hardware—The physical components of a computer that we can see and touch are called hardware. Examples –Keyboard, Mouse.
   b. MICR—Magnetic Ink Character Recognition
   OCR—Optical Character Reader

4. **Observe the given worksheet and answer the following questions.**
   a. Left
   b. Bold, Fill Color
   c. Home tab, Font group
SECTION B (PRACTICAL)

The steps to create the worksheet in Excel 2013 are:

1. Type the data as shown in the worksheet.
2. Click the HOME tab.
   - In the Alignment group, click Merge & Centre button.
   - In the Font group, click Bold, change Font to Times New Roman, and change Font Size to 14.
   - In the Font group, click the Fill Color button and select green. Click the Text color drop down menu arrow and select blue.
5. Select cells A2:C2 and A3:A7. Click the Centre button in the Alignment group.
6. Select cells C3:C7. Click Accounting Number Format in the Number group and select Symbol as English.
7. Select cells A2:C7. Click the Border button in the Font group and select All Borders.

ASSESSMENT 2

SECTION A (THEORY)

1. a. Fill handle  b. Sort  c. Filter  d. Conditional formatting  e. Flash Fill
   f. Objects  g. Template  h. Guides  i. .pub  j. Add level

2. Features used in the publication given alongside are Drop Cap and Text Direction.

3. The three sources from where you can insert a picture in your publication are:
   - from your computer
   - from the Office Clip Art collection
   - from the Internet

4. The rearranged steps are:
   a. In the scratch area, click the picture you want to swap with the picture in your publication.
   b. The selected picture shows the swap icon.
   c. From the scratch area, drag the swap icon of the picture towards the picture on your publication.
   d. When the pink boundary is displayed, release the mouse button to swap the pictures.

5. a. Scratch area
   b. Ctrl + A
   c. Click the Arrange Thumbnails button in the Arrange group on the FORMAT tab under PICTURE TOOLS.
SECTION B (PRACTICAL)

1. Enter the data in a worksheet in cells A1:C11.
   a. To sort the data in ascending order of EmployeeSalary, do the following:
      i. Select a cell in the column according to which you want to sort the data. Here, select a cell in the column C, say C2.
      ii. Click the HOME tab. In the Editing group, click the Sort & Filter button. The drop down list appears.
      iii. Click Sort Smallest to Largest to sort in ascending order.
   b. To format all the rows having salary greater than 50000 with red background, do the following:
      i. Select the range A1:C11 in the worksheet.
      ii. Click New Rule in the Conditional Formatting drop down menu. The New Formatting Rule dialog box appears.
      iii. Under the Select a Rule Type box, click Use a formula to determine which cells to format.
      iv. Under Format values where this formula is true, type ‘=$C$2’ and then click a cell in the EmployeeSalary column of the worksheet, say C2. You will see the value ‘=$C2 > 50000’ appear in the text box. Delete the dollar sign before the row number and type ‘> 50000’. So now you have the value ‘=$C2 > 50000’ in the box.
      v. Click Format. The Format Cells dialog box appears. Click the Fill tab. Choose red as the background colour and click OK.
      vi. You will see the New Formatting Rule dialog box again. Click OK. The rows with EmployeeSalary greater than 50000 now have red colour.
   c. To filter all the records having salary in the range 30000 to 50000, do the following:
      i. Select a cell in the range A1:C11, say B2.
      ii. Click the HOME tab. In the Editing group, click Sort & Filter and select Filter from the drop down list.
      iii. Drop down arrows will appear next to each column heading.
      iv. Click the drop down arrow in the EmployeeSalary column, a menu appears. Click Number Filters. A submenu appears. Select the Between option.
      v. A Custom AutoFilter dialog box appears. Enter 30000 in the first text box and 50000 in the second text box and click OK.
      vi. The filtered rows that satisfied the condition will be displayed in the worksheet.

2. To design an Entry Pass as shown, do the following:
   a. Click the New option of the File menu.
   b. Click the More Blank Pages Sizes option. A list of blank page size appears.
   c. Click Create New page size. The Create New Page Size dialog box appears.
   d. Set the Page Width to 10 cm and Height to 10 cm and click OK.
   e. A customised page will appear on the screen.
   f. To type the heading—Springdale Public School Fete, do the following:
      i. Click the INSERT tab.
      ii. Click the WordArt button in the Text group.
      iii. The WordArt styles gallery will appear. Select the style. The Edit WordArt Text dialog box opens. Enter the text.
Change the Size and click OK.
iv. Place the text at a suitable place.

g. To insert the picture, do the following:
i. Click the INSERT tab.
   ii. Click the Online Pictures option in the Illustrations group. An Insert Pictures dialog box appears. Enter the search name in the Office.com Clip Art text box. A list of pictures will appear. Select the picture and click Insert.
   iii. Place the picture on the entry pass.

h. To insert the Date, Time and Note, do the following:
i. Click the INSERT tab.
   ii. Click Draw Text Box in the Text group.
   iii. Draw the text box on the publication.
   iv. Type the text.
   v. Click the FORMAT tab under DRAWING TOOLS.
   vi. Click the Shapes Fill button in the Shapes Styles group and select the colour.
   vii. Click the Shape Outline button in the Shapes Styles group and select the border colour and weight.

i. To insert the signature of the Principal and the Manager, do the following:
i. Draw text boxes on the publication.
   ii. Type the text. Make it bold.
   iii. To draw a line, click Shapes in the Illustrations group on the INSERT tab.
   iv. Click the line tool and drag it on the publication.
   v. Change the thickness, as required.

j. For the boundary of blue colour, do the following:
i. Draw the text box on the publication.
   ii. Click the FORMAT tab under Drawing Tools.
   iii. Click Shape Outline in the Shapes Styles group and select the desired border and weight.

---

**COMPREHENSIVE ASSESSMENT I**

1. Answer the following in a few words.
d. Margin, Customisable  e. Create Link  f. Wrap Text
g. Ctrl  h. Borders & Accents, Advertisements
j. Microcomputers

2. Answer the following.
a. Compiler—
i. A compiler first reads the whole program and then at one go translates it into machine language.
   ii. The object program is saved permanently for future use.

   Interpreter—
i. An interpreter is a program that translates one statement of a high-level language program into machine code and executes it. It then does the same for the next statement.
   ii. The object code produced by an interpreter is not saved.
b. Utility Software—A utility is a program designed to do maintenance work on the system or on system components. Example, Antivirus software—McAfee; Backup Software.

c. A3 - 10 , A4 - 13 , A5—16

d. Custom filtering is to filter the data based on a specified condition. Two options of custom filtering are Less Than and Greater Than.

e. Click Clear Rules in the Conditional Formatting drop down menu. A submenu appears, select Clear Rules from Entire Sheet.

3. Fill in the blanks
   a. hardware   b. barcode   c. banks   d. Optical Mark Reader   e. plotter

4. Write T for the true statement and F for the false one. Correct the false statement(s).
   a. T
   b. T
   c. F. You can sort/filter data according to cell colour.
   d. F. You can sort data on two fields.
   e. F. Filtering means to display the data that satisfies a condition.

5. The ten formatting features applied to the data are:
   a. Font    b. Font Size       c. Bold     d. Fill Color
   e. Font Color   f. Wrap Text       g. Merge & Centre   h. Border
   i. Middle Align   j. Accounting Number format

6. Choose the correct option.
   a. iv. Java        b. ii. Best Fit       c. ii. Drop Cap
   d. i. Four-sided    e. ii. Extends a sequential range of data   f. iii. Flash Fill
   g. iii. File Options Advanced h. i. Home       i. ii. Reapply
   j. ii. Top 10

ASSESSMENT 3

SECTION A (THEORY)

1. a. i. Uniform Resource Locator
   ii. World Wide Web
   iii. Blind Carbon Copy

   b. The two types of addressing systems are:
      Letter addressing system, e.g., pakistan.gov.pk
      Number addressing system, e.g., 192.12.148.73

2. Match the following.
   a. iii.  b. iv.   c. ii.   d. v.   e. i.
3. Answer the following in one word.

4. Give the full form of the following.
   a. Modulator Demodulator       b. Internet Service Provider

---

ASSESSMENT 4

SECTION A (THEORY)

1. STRAIGHTEN, SMOOTH, INK

2. Define the following.
   a. Symbol—A symbol is a graphic image, animation, or button that is stored along with a movie.
   b. Instance—Instance is an occurrence of a symbol.
   c. Frame Rate—Frame rate shows the number of frames per second that your animation will play.
3. **Answer the following in one word.**
   a. Stroke  
   b. Arrow (Selection) tool  
   c. Oval tool  
   d. Tools panel  
   e. Timeline  

4. **Observe the following figure and answer the given questions.**
   a. i. Tools panel  
   ii. Timeline  
   iii. Property Inspector  
   b. Stage. It is the place where graphics, text, and video clips are placed and the movie is created.  
   c. Modify menu and Document option  

---

**SECTION B (PRACTICAL)**

1. **Start Flash CS3 and create a new file. To create the given animation do the following:**
   a. Select the first frame in the Timeline.  
   b. Select the Oval Tool. Then select the stroke colour and fill colour.  
   c. Draw a circle on the Stage.  
   d. Select frame 20 in the Timeline and insert a Blank Keyframe by pressing F7 or by selecting **Insert ➤ Timeline ➤ Blank Keyframe.**  
   e. Draw a star on the stage. Change the stroke colour and fill colour.  
   f. Click on any frame between 1 and 20 in the Timeline. Right-click and select the Create Shape Tween option from the context menu.  
   g. Select Frame 1 in the Timeline and press Enter to play the movie.  

---

**COMPREHENSIVE ASSESSMENT II**

1. **Fill in the blanks.**
   a. ReadNumber( )  
   b. 2  
   c. Library  

2. **Write T for the true statement and F for the false one. Correct the false statement(s).**
   a. T  
   b. F. The arithmetic ‘*’ can be used in Small Basic.  
   c. T  

3. **Answer the following in one or two words**
   a. Program  
   b. Numeric and String  
   c. Write( ) and WriteLine( )  
   d. Conditional  
   e. .sb  
   f. Default mode in Flash—Merge Drawing mode  
   g. Lasso Tool  
   h. Property Inspector  

4. **Answer the following**
   a. The three letters of the domain name are important because they provide information about the kind of organisation to which the address belongs.
b. It is important to sign out of your email account properly, especially when you are using a public or shared computer. This will prevent misuse of your account by other people who will use this computer.

c. Advantages of email are:
   i. Email is much quicker than normal post.
   ii. We need not be at our computer all the time to receive a message.

5. ```
1 TextWindow.Write("Enter the first number")
2 a = TextWindow.ReadNumber()
3 TextWindow.Write("Enter the second number")
4 b = TextWindow.ReadNumber()
5 If a < b Then
6   l = a
7 Else
8   l = b
9 EndIf
10 TextWindow.WriteLine("The smallest number is " + l)
```  

6. ```
1 TextWindow.Write("Enter the side of a square")
2 side = TextWindow.ReadNumber( )
3 area = side * side
4 perimeter = 4 * side
5 TextWindow.WriteLine("Area of a Square = " + area)
6 TextWindow.WriteLine("Perimeter of a Square = " + perimeter)
```  

7. a. i 20,000    ii 3750  
b. The value of the discount will be printed from the next line  
c. The line TextWindow.WriteLine(“Discount = “ + discount) uses the property of concatenation.  
d. This program calculates and displays the discount

8. Choose the correct option.
   a. iv. Print  
   b. iii. 255  
   c. ii. Inbox  
   d. iv. all of these  
   e. i. Property Inspector  
   f. ii. Primitive Rectangle Tool  
   g. i. Rectangle Tool  
   h. ii. F6  
   i. iii. .fla

#### CYBER OLYMPIAD QUESTIONS

1. c  
2. d  
3. d  
4. a  
5. d  
6. d  
7. a  
8. b  
9. b  
10. d  

11. d  
12. a  
13. a  
14. c  
15. a  
16. c  
17. a  
18. d  
19. a  
20. b  

21. a  
22. a  
23. a  
24. b  
25. d  
26. c  
27. c  
28. d  
29. d  
30. d  

31. d  
32. d  
33. b  
34. b  
35. a  
36. c  
37. d  
38. b  
39. b  
40. c
Revision Questions

1. An optical character reader is a device used to input normal, printed, or hand-written text. A Magnetic Ink Character Reader is used to scan characters printed in magnetic ink. MICR is extensively used in banks.

2. Two types of Application Software are—packages and utilities.
   Example of Packages—Microsoft Word
   Example of Utility—Antivirus Software Quick Heal

3. Microcomputers are used in offices, schools, and homes.

4. Low level languages are machine dependent, so codes written for one machine might not work on the other.
   High level languages use English and mathematical symbols and they make computer programming simpler.
   High-level language programs are machine independent. They can run on different types of computers without change.

5. A driver is a computer program that enables a computer to interact with a hardware device such as printer.

6. Feb, Mar, Apr, May

7. The two ways of creating a Custom List are Import and Add.

8. Select the list in Custom Lists box. The list appears in List entries box. Click Delete button. A confirmation box appears. Click OK.

9. The Flash Fill feature recognises the data fill pattern in a worksheet and fills the remaining series accordingly.
   For example, consider the worksheet
   
<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Last Name</td>
<td>First Name</td>
<td>Full Name</td>
</tr>
<tr>
<td>2</td>
<td>Chaudhary</td>
<td>Sabeen</td>
<td>C</td>
</tr>
<tr>
<td>3</td>
<td>Tariq</td>
<td>Azam</td>
<td>A</td>
</tr>
<tr>
<td>4</td>
<td>Dua</td>
<td>Noshad</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Jamil</td>
<td>Sumayyah</td>
<td></td>
</tr>
</tbody>
</table>

   Enter Monica C Chowdhary in cell D2. In cell D3, start typing the first Name Siddhant. As you do, the Flash Fill logic suggests a series of values to fill in cells D3:D5

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Last Name</td>
<td>First Name</td>
<td>Full Name</td>
</tr>
<tr>
<td>2</td>
<td>Chaudhary</td>
<td>Sabeen</td>
<td>C</td>
</tr>
<tr>
<td>3</td>
<td>Tariq</td>
<td>Azam</td>
<td>A</td>
</tr>
<tr>
<td>4</td>
<td>Dua</td>
<td>Noshad</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Jamil</td>
<td>Sumayyah</td>
<td></td>
</tr>
</tbody>
</table>

   Press Enter to accept the suggestions.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Last Name</td>
<td>First Name</td>
<td>Full Name</td>
</tr>
<tr>
<td>2</td>
<td>Chaudhary</td>
<td>Sabeen</td>
<td>C</td>
</tr>
<tr>
<td>3</td>
<td>Tariq</td>
<td>Azam</td>
<td>A</td>
</tr>
<tr>
<td>4</td>
<td>Dua</td>
<td>Noshad</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Jamil</td>
<td>Sumayyah</td>
<td></td>
</tr>
</tbody>
</table>

10. To delete the conditional formatting applied to a worksheet, click Clear Rules in the Conditional Formatting drop down menu. A submenu appears. Click Clear Rules from Entire Sheet.

11. To add a customised guide, click either the horizontal or the vertical ruler. Drag the mouse to your publication and release to add the guide at the desired location.

12. To connect the text box:
   a. Select the left text box. Click the FORMAT tab under TEXT BOX TOOLS and in the Linking group click Create Link.
b. The cursor changes to the link (a pitcher) icon. Click in the text box that you want to link, usually it is the text box on the right.

The text boxes will be linked. Resize the linked box as necessary. Any text that overflows from the original text box will now appear in the connected box.

13. The steps to add a picture in the picture placeholder are:
   a. Click to display the boundary of the picture placeholder and the picture placeholder icon.
   b. Click the placeholder icon to display the Insert Pictures dialog box.
   c. Click the **Office.com Clip Art** option to place the insertion point in the respective search box. Type the search term in the search box and press ENTER. A list of pictures appears.
   d. Click the picture you want to insert and click the **Insert** button. The picture gets inserted in the publication.

14. The steps to add a caption to a picture are:
   a. Select the picture.
   b. Click the **FORMAT** tab under **PICTURE TOOLS**.
   c. Click the **Caption** button in the **Picture Styles** group. The **Caption** gallery appears.
   d. Select your preferred choice. To edit the caption text, just select it and type the new text.

15. The two input methods in Small Basic are:
   a. **ReadNumber( ):** It allows reading numeric (integer and floating) inputs.
   b. **Read( ):** It allows reading string input.

16. The rules for naming variables are:
   a. They can only be made up of letters, numbers, and the underscore character.
   b. The first character must be a letter.
   c. They cannot be a reserved word of Small Basic.

17. Excel comes with pre-designed cell styles rather than formatting cells manually. It is a quick way to include professional formatting for different parts of a workbook such as title, headers, and more. To apply a cell style,
   a. Select cell(s) where you want to apply formatting.
   b. Click the Cell Styles command in the Styles group on the Home tab and select the desired style from the drop down menu. A live preview of a format displays as you move the pointer. The selected cell style will appear.

18. A reserved word has a special meaning to the compiler and cannot be used as a variable name.

19. A comment statement is used to provide explanation about the code. This helps the programmer to understand and modify the code later on if required. It is non-executable and ignored by the compiler. An apostrophe is used as the comment symbol. Anything written after the comment symbol will be ignored by the compiler. For example,
   ```
   'This is a comment statement.
   ```

20. Concatenation means to add two string values one after another. For example,
    ```
    A = “Hello!”
    B = “How are you ?”
    C = A + B
    TextWindow.Write(C)
    ```
    The output will be: **Hello! How are you?**
21. The hierarchy of operators for evaluating an arithmetic expression is:
   - Parenthesis
   - Multiplication and division
   - Addition and Subtraction

22. The `WriteLine()` method after printing moves the pointer to the next line and the `Write()` method after printing makes the pointer stay on the same line.

23. 3.1415

24. `TextWindow.Write ("Enter your name")
   name = TextWindow.Read()
   TextWindow.WriteLine("Hello!" + name)

25. F5

26. a. 1
   b. 56

27. Email is far quicker than normal post. A message can reach any part of the world in a fraction of a second. We need not be at our computer all the time to receive a message.

28. Example of Number addressing scheme - 192.12.145.72
    Example of letter addressing system—google.pk

29. Cc stands for carbon copy. It allows you to send the same message to two or more people at one go. BCc stands for Blind Carbon Copy. It allows you to send the same message to several people without letting them know that others have also received the same mail.

30. The two options of the Magnifier Tool are—Zoom In and Zoom Out.

31. The Lasso Tool is used to select irregular areas in a drawing.

32. Timeline window is used to set the sequence of the movie.

33. The keyboard shortcut to display the grid in Flash is Ctrl + ‘

34. The steps to draw a star shape using Polystar tool are:
   a. Select the PolyStar Tool.
   b. From the Property Inspector, select the stroke and fill attributes.
   c. Click the Options button in the Property Inspector. The Tool Settings dialog box appears.
      i. Select Star for Style.
      ii. Specify number of sides.
      iii. Enter a number between 0 and 1 for the Star point size.
      iv. Click OK to close the dialog box.
   d. Click on the stage and drag to draw the shape.

35. The steps to create a new gradient are:
   a. Select Colour option from Windows menu. The Colour panel appears.
   b. Click the drop down arrow of the Type box and select a gradient style—Linear or Radial.
   c. Click the colour marker you want to change. The colour palette appears.
   d. Select a colour. You can also click and shift the colour marker left or right on the gradient bar to adjust the gradient.
   e. To add another colour marker, click below the gradient bar. To remove a colour marker, drag it off the bar.
   f. You can continue creating the gradient effect by adding colour markers and assigning colours to them.
36. The different modifiers of the Pencil Tool are—Straighten, Smooth and Ink.

37. A symbol is a graphic image, animation, or button that is stored along with a movie.

38. The steps to insert a keyframe are:
   a. In the Timeline window, click on a rectangular placeholder where you want to insert a keyframe.
   b. Select Insert ➤ Timeline ➤ Keyframe.

39. A black dot represents a keyframe.

40. The steps to convert an existing drawing into a symbol are:
   a. Select the Arrow (Selection) Tool.
   b. Draw a selection area around the object on the Stage to select it.
   c. Select Modify ➤ Convert to Symbol. The Convert to Symbol dialog box appears.
      i. Type a Name for the symbol.
      ii. Type of symbol can be a Movie clip, a Button, or a Graphic. Choose Graphic.
      iii. Click OK. The symbol now gets added to the Library panel.
WORKSHEETS

- Worksheets have been provided for all the chapters of the course book.
- Each worksheet is of 15 marks and is recommended as a formative assessment paper.
- It is possible to use these worksheets as they are by photocopying them in magnified size (120% approx.) and distributing to the students.
- The questions in the worksheets may also be used as samples to create your own additional worksheets.
- They are also available as printable documents online digital resources.
Chapter 1 The Computer System

1. Complete the crossword based on the clues given: (5)

ACROSS
2. These computers are big, powerful computers used for bulk data processing.
3. It is a computer application consisting of one or more programs.

DOWN
1. It refers to the computer programs needed for running or operating a computer system.
4. It is a program that translates high-level language program into machine code.
5. It is used to read information stored on cards such as magnetic strip cards.

2. Unjumble the letters to form words using the hints given: (5)
   a. OMPCLIER .................................................................
      Hint: It translates the high-level program into machine language program.
   b. TPOLTER .................................................................
      Hint: It is a printing device used for creating high quality graphics.
   c. PTOLPA .................................................................
      Hint: It is the portable version of the desktop PC.
   d. PTINU VIDECE .......................................................  
      Hint: It is a device that accepts input from the user.
e. USOREC GRPRAMO .................................................................
   Hint: It is the program written in high-level language.

3. **Who Am I?**
   (5)
   a. I am the physical component of the computer system. ........................................
   b. I am the language that the computer understands and can execute directly without translation. ........
      ................................
   c. I am the computer program that enables a computer to interact with a hardware device. ..................
      ........................
   d. I am the technology that is used for checking answer sheets of exams that have multiple choice questions.
      ........................................
   e. I am the biggest and the most powerful computer and I can process trillions of instructions per second.
      ........................................
Chapter 2 Formatting Data in Excel 2013

1. Unjumble the letters to form words using the hints given: (5)
   a. MTINGAENL .................................................................
      Hint: It is the position where data is placed within the boundary of a cell.
   b. PRAW EXTT .................................................................
      Hint: The option by which the data is confined to the cell but is displayed in multiple lines.
   c. OTNF .................................................................
      Hint: A set of letters of the alphabet and numbers written in a particular style.
   d. NNIERTATIOO .................................................................
      Hint: It is the relative physical position or direction of text.
   e. INREDLUNE .................................................................
      Hint: It is a type of text formatting.

2. Who Am I? (5)
   a. I am the keyboard shortcut for formatting text in Italics. ..................
   b. I am the default vertical alignment for any text entered in the worksheet. ..................
   c. I am the group on the HOME tab where the Cell Styles button can be found. ..................
   d. I am the default font in Excel 2013. ..................
   e. I am the combination of keys used to write data in multiple lines in the same cell. ..................

3. Identify the components A to E in the following figure of the Font group on the HOME tab. (5)

   A. ....................................................     B. ....................................................
   C. ....................................................     D. ....................................................
   E. ....................................................
Chapter 3  Advanced Features of Excel 2013

1. Unjumble the letters to form words using the hints given: (5)
   a. INTLUOE ......................................................................................
      Hint: It is the group on the DATA tab where the Subtotal button is found.
   b. FAMORT TEINAPR ......................................................................................
      Hint: The tool using which the conditional formatting can be copied to other cells.
   c. SSTELY ......................................................................................
      Hint: It is the group on the HOME tab where the Conditional Formatting command is available.
   d. IIETLRFNG ......................................................................................
      Hint: It is the feature of Excel 2013 that enables the user to easily view the highest and lowest values from a large set of data.
   e. AELCR SELUR ......................................................................................
      Hint: It is the option in the Conditional Formatting drop down menu to clear conditional formatting.

2. Who Am I? (5)
   a. I am the small black square in the lower right corner of the active cell(s). ......................
   b. I am the feature in Excel 2013 that recognises the data fill pattern in a worksheet and fills the remaining series accordingly. .........................
   c. I am the group on the HOME tab where the Sort & Filter button can be found. .................
   d. I am the feature of Excel 2013 using which one can rearrange the data in ascending or descending order. ........................................
   e. I am an ordered list of frequently used text entries that the user can enter quickly through AutoFill. ........................

3. Search for the following five terms related to Excel 2013 in the grid on the right: (5)
   **Words:** SORTING; AUTO FILL; FILTER; FLASH FILL; CUSTOM LIST

<table>
<thead>
<tr>
<th>R</th>
<th>E</th>
<th>S</th>
<th>O</th>
<th>R</th>
<th>T</th>
<th>I</th>
<th>N</th>
<th>G</th>
<th>A</th>
<th>T</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Q</td>
<td>R</td>
<td>E</td>
<td>U</td>
<td>W</td>
<td>K</td>
<td>O</td>
<td>S</td>
<td>H</td>
<td>D</td>
<td>K</td>
</tr>
<tr>
<td>C</td>
<td>U</td>
<td>S</td>
<td>T</td>
<td>O</td>
<td>M</td>
<td>L</td>
<td>I</td>
<td>S</td>
<td>T</td>
<td>H</td>
<td>A</td>
</tr>
<tr>
<td>T</td>
<td>R</td>
<td>A</td>
<td>N</td>
<td>S</td>
<td>I</td>
<td>T</td>
<td>E</td>
<td>O</td>
<td>P</td>
<td>U</td>
<td>U</td>
</tr>
<tr>
<td>C</td>
<td>U</td>
<td>S</td>
<td>T</td>
<td>O</td>
<td>M</td>
<td>A</td>
<td>F</td>
<td>S</td>
<td>T</td>
<td>V</td>
<td>T</td>
</tr>
<tr>
<td>Z</td>
<td>X</td>
<td>B</td>
<td>A</td>
<td>W</td>
<td>A</td>
<td>D</td>
<td>I</td>
<td>A</td>
<td>V</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>F</td>
<td>L</td>
<td>A</td>
<td>S</td>
<td>H</td>
<td>F</td>
<td>I</td>
<td>L</td>
<td>L</td>
<td>R</td>
<td>G</td>
<td>F</td>
</tr>
<tr>
<td>G</td>
<td>S</td>
<td>D</td>
<td>E</td>
<td>T</td>
<td>I</td>
<td>T</td>
<td>T</td>
<td>P</td>
<td>B</td>
<td>S</td>
<td>I</td>
</tr>
<tr>
<td>F</td>
<td>B</td>
<td>F</td>
<td>R</td>
<td>U</td>
<td>L</td>
<td>T</td>
<td>E</td>
<td>R</td>
<td>B</td>
<td>A</td>
<td>L</td>
</tr>
<tr>
<td>V</td>
<td>A</td>
<td>P</td>
<td>L</td>
<td>N</td>
<td>E</td>
<td>E</td>
<td>R</td>
<td>O</td>
<td>D</td>
<td>D</td>
<td>L</td>
</tr>
</tbody>
</table>
Chapter 4  Introducing Publisher 2013

1. Search for five words related to Publisher in the grid below: (5)

| L | J | S | W | A | S | H | T |
| I | R | L | W | I | G | N | O |
| G | U | I | A | R | I | Y | B |
| A | L | G | S | U | N | T | J |
| T | E | M | P | L | A | T | E |
| U | R | O | R | E | E | R | C |
| R | S | R | M | R | T | E | T |
| E | M | A | O | S | A | W | S |

2. Label the parts marked from A to E of the Publisher screen: (5)

A. ..............................................................
B. ..............................................................
C. ..............................................................
D. ..............................................................
E. ..............................................................

3. Who Am I? (5)
   a. I am the folder which shows the entire set of templates for birthday cards.
      ..............................................................
   b. I am a text-formatting style that enlarges the first letter of the selected text.
      ..............................................................
   c. I am the view in the Publisher interface which is used to manage files, e.g., opening, saving, closing files, etc.
      ..............................................................
   d. I am the blue lines that mark the edges of the printable area on each page of the publication.
      ..............................................................
   e. I am the group on the HOME tab which has the options for drawing a text box.
      ..............................................................
Chapter 5  Graphics in Publisher 2013

1.  Search for five words related to graphics in Publisher in the grid below:  (5)

   | N | J | W | Z | A | S | R | T | E |
   | C | A | P | T | I | O | N | O | Y |
   | R | U | I | A | R | I | Y | B | I |
   | O | L | G | R | E | S | I | Z | E |
   | P | O | U | C | J | N | L | I | L |
   | S | R | O | R | E | E | W | C | C |
   | T | S | R | M | R | T | R | T | F |
   | T | H | U | M | B | N | A | I | L |
   | G | K | S | E | J | X | P | P | D |

2.  Unjumble the letters to form words using the hints given:  (5)
   a.  CSATHRC REAA .................................................................
       Hint: It is the grey area that is the temporary holding area in a publication
   b.  PCEALOLHERD .................................................................
       Hint: A picture frame that provides a specific shape and size to hold the selected picture.
   c.  WASP .................................................................
       Hint: Icon that appears after a placeholder has been replaced with a picture.
   d.  ILFL .................................................................
       Hint: It is one of the options in the ‘Apply to Background’ submenu that covers the entire page.
   e.  AGPE PTASR .................................................................
       Hint: A type of building block in Publisher.

3.  Who Am I?  (5)
   a.  I am the tab that appears on the ribbon on inserting a shape in the publication. .................................
   b.  I am the feature that provides artistic effects to the picture by changing the picture shape, border, and other effects. .................................................................
   c.  I am the group under the Insert tab that has options to insert pictures in a publication. .................................
   d.  I am the identification text that accompanies a graphic. .................................................................
   e.  I am the building block that is used to add borders, frames, etc., in a publication. .................................................................
Chapter 6  Basics of MS Small Basic

1. Complete the crossword based on the clues given: (5)

   ACROSS
   2. The window present at the centre of the screen, where Small Basic programs are written.
   3. The data or value that cannot be changed in a program.
   4. It is an action that an object in Small Basic can perform.

   DOWN
   1. A sequence of instructions written to perform a particular task.
   3. A statement that is used to provide explanation about the code.

2. Unjumble the letters to form words using the hints given: (5)

   a. TECOJB ............................................................
      Hint: It is the fundamental building block of Small Basic.
   b. OREPROTA ............................................................
      Hint: A symbol used to perform a certain task on variables.
   c. PPORYERT ............................................................
      Hint: An attribute of an object in Small Basic.
   d. DORWYEK ............................................................
      Hint: A reserved word in Small Basic.
   e. NOCCTANTAONIE ............................................................
      Hint: An operator used for joining one string to another.

3. Who Am I? (5)

   a. I am the data or value in a program which cannot be changed during program execution.
   b. I am the operator used to compare the values of two expressions.
   c. I am a combination of constants, variables, and operators.
   d. I assign a value to a variable.
   e. I am also called a branching statement.
Chapter 7  The Internet as a Post Office

1. Complete the crossword based on the clues given:  (5)

   ACROSS
   1. It is a collection of web pages with related information.
   2. It is the front page or index page of any website.

   DOWN
   3. It is a computer peripheral that lets users connect their computer to other computers using wired or wireless telephone connections in order to transmit and receive data.
   4. The last three letters of the domain name for a military organisation.
   5. It is the process of exploring the Internet.

2. Unjumble the letters to form words using the hints given:  (5)
   a. EBW WSEORBR ...........................................................
      Hint: It reads HTML documents, converts them to a form that users can read, and displays them on a computer screen.
   b. RRUOSECE ...........................................................
      Hint: In the acronym URL, it is the expansion for “R”.
   c. OBIXN ...........................................................
      Hint: It is the email folder that stores the incoming email messages.
   d. SHTRA ...........................................................
      Hint: It is the email folder that stores deleted messages.
   e. CEVRIES ...........................................................
      Hint: In the acronym ISP, it is the expansion for “S”.
3. Search for five commonly used Email commands in the grid below:

<table>
<thead>
<tr>
<th>R</th>
<th>E</th>
<th>P</th>
<th>E</th>
<th>A</th>
<th>R</th>
<th>S</th>
<th>A</th>
<th>M</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>F</td>
<td>O</td>
<td>R</td>
<td>W</td>
<td>A</td>
<td>R</td>
<td>D</td>
<td>H</td>
<td>O</td>
<td>D</td>
</tr>
<tr>
<td>N</td>
<td>E</td>
<td>S</td>
<td>L</td>
<td>I</td>
<td>I</td>
<td>E</td>
<td>E</td>
<td>I</td>
<td>J</td>
</tr>
<tr>
<td>D</td>
<td>H</td>
<td>S</td>
<td>R</td>
<td>G</td>
<td>P</td>
<td>M</td>
<td>S</td>
<td>E</td>
<td>L</td>
</tr>
<tr>
<td>G</td>
<td>D</td>
<td>D</td>
<td>E</td>
<td>R</td>
<td>L</td>
<td>T</td>
<td>Z</td>
<td>P</td>
<td>E</td>
</tr>
<tr>
<td>F</td>
<td>O</td>
<td>F</td>
<td>P</td>
<td>S</td>
<td>Y</td>
<td>W</td>
<td>P</td>
<td>I</td>
<td>T</td>
</tr>
<tr>
<td>P</td>
<td>R</td>
<td>I</td>
<td>N</td>
<td>T</td>
<td>E</td>
<td>E</td>
<td>R</td>
<td>O</td>
<td>E</td>
</tr>
<tr>
<td>B</td>
<td>S</td>
<td>T</td>
<td>Y</td>
<td>K</td>
<td>L</td>
<td>N</td>
<td>U</td>
<td>R</td>
<td>P</td>
</tr>
<tr>
<td>A</td>
<td>C</td>
<td>O</td>
<td>M</td>
<td>P</td>
<td>O</td>
<td>S</td>
<td>E</td>
<td>N</td>
<td>E</td>
</tr>
</tbody>
</table>
Chapter 8  Introduction to Flash CS3

1. List three facts about the following:  (6)
   a. Merge Drawing Mode
   b. Object Drawing Mode

2. Unjumble the letters to form words using the hints given:  (5)
   a. ORARW OTOL ............................................................
      Hint: It is also called the Selection Tool.
   b. REPPORYT OTCPESNIR ............................................................
      Hint: It is the panel that displays the properties of the selected object.
   c. RIDG ............................................................
      Hint: It is a system of intersecting horizontal and vertical lines on the stage.
   d. OSSAL LOTO ............................................................
      Hint: It is the tool that is used to select irregular areas in the drawing.
   e. EMITENIL ............................................................
      Hint: It is the panel in the Flash window that is used to set the sequence of the movie.

3. Who Am I?  (4)
   a. I am the keyboard shortcut to show/hide rulers. ............................................................
   b. I am the extension for a Flash File. ............................................................
   c. I am the keyboard shortcut to open the Document Properties dialog box.
      ............................................................
   d. I am the tool that is used for clicking and dragging while holding down the mouse button............................................................
Chapter 9 Drawing Tools in Flash CS3

1. Search for the five drawing tools in the grid given below: (5)

```
R R C O O R S J L K E
E R A V S G T I U M N
N E S A I N E I D U P
D C S L I N E S F P E
G S D E R I T Z P S N
R E C T A N G L E R C
V A P L T E E R O J I
A N E R A S E R N X L
```

2. Who Am I? (5)
   a. I am the tool that is used to draw polygons or stars. ......................................
   b. I am the tool that is used to fill enclosed areas with solid colours and gradients. ......................................
   c. I am the tool that is used to change the colour, style, and thickness of the existing lines. ..........................
   d. I am the term for a colour created by mixing two or more colours. ......................................
   e. I am the tool that is used to create square shapes. ......................................

3. Figure Speak (5)
The shapes marked A to E in the figure given alongside were created using the Brush Tool and by applying different Painting Modes in the Brush Mode Modifier. Identify the Painting Modes used in shapes A to E.

A. ...........................................................
B. ...........................................................
C. ...........................................................
D. ...........................................................
E. ...........................................................
Chapter 10: Creating Animations in Flash CS3

1. Complete the crossword based on the clues given: (5)

ACROSS
1. It is the basic unit of any movie.
2. It is a red rectangle with a vertical line which indicates the current frame on the Stage and the current status of the movie.
3. It is the term used for an occurrence of a symbol in a movie.

DOWN
4. It is a graphic image, animation, or button that is stored along with a movie.
5. It is a folder in Flash CS3 that stores symbols.

2. Who Am I? (5)
   a. I am a critical point in an animation, where an object appears or changes, or begins or ends an action such as fading, moving, etc. ...................................
   b. I am the keyboard shortcut to open the Library panel. .................................
   c. I am the term used for the number of frames per second that an animation will play. ...................................
   d. I am the process which makes a drawing change into another drawing. ...................................
   e. I am the menu in which the Play option is available. .................................

3. Identify the components of the Timeline window marked from A to E in the figure given below. (5)
A. ........................................................
B. ........................................................
C. ........................................................
D. ........................................................
E. ........................................................
WORKSHEET ANSWERS

Chapter 1  The Computer System


2. 1. COMPILER; 2. PLOTTER; 3. LAPTOP;
   4. INPUT DEVICE; 5. SOURCE PROGRAM

   4. Optical Mark Recognition; 5. Supercomputer

---

Chapter 2  Formatting Data in Excel 2013

1. a. ALIGNMENT b. WRAP TEXT c. FONT
   d. ORIENTATION e. UNDERLINE

2. a. Ctrl + I b. Bottom c. Styles
   d. Calibri e. Alt + Enter

3. A. Fill Color B. Decrease Font Size C. Borders
   D. Font Color E. Bold

---

Chapter 3  Advanced Features of Excel 2013

1. a. OUTLINE b. FORMAT PAINTER c. STYLES d. FILTERING e. CLEAR RULES

2. a. Fill Handle b. Flash Fill c. Editing d. Sorting e. Custom List

3. R E S O R T I N G A T D
   A Q R E U W K O S H D K
   C U S T O M L I S T H A
   T R A N S I T E O P U U
   C U S T O M A F S T V T
   Z X B A W A D I A V O O
   F L A S H F I L L R G F
   G S D E T I T T P B S I
   F B F R U L T E R B A L
   V A P L N E E R O D D L

---
Chapter 4  Introducing Publisher 2013

1. 

<table>
<thead>
<tr>
<th>L</th>
<th>J</th>
<th>S</th>
<th>W</th>
<th>A</th>
<th>S</th>
<th>H</th>
<th>T</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>R</td>
<td>L</td>
<td>W</td>
<td>I</td>
<td>G</td>
<td>N</td>
<td>O</td>
</tr>
<tr>
<td>G</td>
<td>U</td>
<td>I</td>
<td>A</td>
<td>R</td>
<td>I</td>
<td>Y</td>
<td>B</td>
</tr>
<tr>
<td>A</td>
<td>L</td>
<td>G</td>
<td>S</td>
<td>U</td>
<td>N</td>
<td>T</td>
<td>J</td>
</tr>
<tr>
<td>T</td>
<td>E</td>
<td>M</td>
<td>P</td>
<td>L</td>
<td>A</td>
<td>T</td>
<td>E</td>
</tr>
<tr>
<td>U</td>
<td>R</td>
<td>O</td>
<td>R</td>
<td>E</td>
<td>E</td>
<td>R</td>
<td>C</td>
</tr>
<tr>
<td>R</td>
<td>S</td>
<td>R</td>
<td>M</td>
<td>R</td>
<td>T</td>
<td>E</td>
<td>T</td>
</tr>
<tr>
<td>E</td>
<td>M</td>
<td>A</td>
<td>O</td>
<td>S</td>
<td>A</td>
<td>W</td>
<td>S</td>
</tr>
</tbody>
</table>

2. A. Quick Access Toolbar   B. Page Navigation Pane   C. Ruler  
   D. Tabs  E. Ribbon

3. a. All Birthday   b. Drop Cap   c. Backstage view  
   d. Margin guides  e. Objects

Chapter 5  Graphics in Publisher 2013

1. 

<table>
<thead>
<tr>
<th>N</th>
<th>J</th>
<th>W</th>
<th>Z</th>
<th>A</th>
<th>S</th>
<th>R</th>
<th>T</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>A</td>
<td>P</td>
<td>T</td>
<td>I</td>
<td>O</td>
<td>N</td>
<td>O</td>
<td>Y</td>
</tr>
<tr>
<td>R</td>
<td>U</td>
<td>I</td>
<td>A</td>
<td>R</td>
<td>I</td>
<td>Y</td>
<td>B</td>
<td>I</td>
</tr>
<tr>
<td>O</td>
<td>L</td>
<td>G</td>
<td>R</td>
<td>E</td>
<td>S</td>
<td>I</td>
<td>Z</td>
<td>E</td>
</tr>
<tr>
<td>P</td>
<td>O</td>
<td>U</td>
<td>C</td>
<td>J</td>
<td>N</td>
<td>L</td>
<td>I</td>
<td>L</td>
</tr>
<tr>
<td>S</td>
<td>R</td>
<td>O</td>
<td>R</td>
<td>E</td>
<td>E</td>
<td>W</td>
<td>C</td>
<td>C</td>
</tr>
<tr>
<td>T</td>
<td>S</td>
<td>R</td>
<td>M</td>
<td>R</td>
<td>T</td>
<td>R</td>
<td>T</td>
<td>F</td>
</tr>
<tr>
<td>T</td>
<td>H</td>
<td>U</td>
<td>M</td>
<td>B</td>
<td>N</td>
<td>A</td>
<td>I</td>
<td>L</td>
</tr>
<tr>
<td>G</td>
<td>K</td>
<td>S</td>
<td>E</td>
<td>J</td>
<td>X</td>
<td>P</td>
<td>P</td>
<td>D</td>
</tr>
</tbody>
</table>

2. a. SCRATCH AREA   b. PLACEHOLDER   c. SWAP  
   d. FILL  e. PAGE PARTS

3. a. Drawing Tools tab   b. Picture Style   c. Illustrations  
   d. Caption  e. Borders & Accents
Chapter 6 Basics of Small Basic

1. Across: 2. Editor; 3. Constant; 4. Method
   Down: 1. Program; 3. Comment

2. a. OBJECT           b. OPERATOR           c. PROPERTY
    d. KEYWORD          e. CONCATENATION

3. a. Constant         b. Comparison operator     c. Expression
    d. Assignment statement  e. Conditional statement.

Chapter 7 The Internet as a Post Office

   Down: 3. Modem; 4. MIL; 5. Surfing

2. a. WEB BROWSER      b. RESOURCE           c. INBOX
    d. TRASH            e. SERVICE

3. 
   REPEARSAME
   FORWARDHOD
   NELSEIELJE
   DHRGPMSEL
   GDERTZPE
   FOFPSTWPIT
   PRINTEERO
   BSTYKLNURP
   ACMPONSENE

Chapter 8 Introduction to Flash CS3

1. a. Merge Drawing Mode:
   i. This is the default drawing mode.
   ii. In this mode, if two shapes are overlapped, they merge together.
   iii. In this mode, the covered area of the lower object is erased.

   b. Object Drawing Mode:
   i. This model draws shapes as separate objects.
   ii. The shapes can be moved apart without altering their appearance.
   iii. When you select an object in this mode, it gets surrounded by a rectangular bounding box.
2. a. ARROW TOOL  b. PROPERTY INSPECTOR  c. GRID
d. LASSO TOOL  e. TIMELINE
3. a. Ctrl+Shift+Alt  b. .fla  c. Ctrl+J
d. Hand Tool

Chapter 9  Drawing Tools in Flash CS3

1. 

2. a. Polystar  b. Paint Bucket  c. Ink Bottle
d. Gradient  e. Rectangle

3. A. Paint Normal  B. Paint Fills  C. Paint Selection
   D. Paint Inside  E. Paint Behind

Chapter 10: Creating Animations in Flash CS3

   Down:  4. Symbol;  5. Library
2. a. Keyframe  b. CTRL + L  c. Frame Rate
d. Shape Tweening  e. Control
3. A. Frames  B. Keyframe  C. Elapsed Time
   D. Frame Rate  E. Current Frame
TEST PAPERS

- Test papers have been provided for all the chapters of the course book.
- Each test paper is of 25 marks and has both theory (20) and practical (5) components.
- The test papers may be used for pen and paper assessment or the questions in them could be used to create your own assessment papers.
- They are also available as printable documents in online digital resources
Chapter 1  The Computer System

1. Fill in the Blanks  
   a. A tablet is a type of .................................. computer.
   b. .................................. is a famous e-book reader.
   c. .................................. are large computers of the size of refrigerators.
   d. A .................................. printer is used to produce printouts for blind people.

2. Write T for the true statement and F for the false one.  
   a. An assembler is a high-level language.
   b. Cheque information is read by an MICR reader.
   c. Minicomputers are portable mobile computers.
   d. Application software has two categories- packages and utilities.
   e. A program in a high-level language is called an assembly program.

3. Very Short Answer Questions  
   a. Name two output devices other than printers.
   b. What are the two different categories of application programs?
   c. What is the full form of OCR?
   d. Give two examples of high-level languages.
   e. What is a utility?

4. Short Answer Questions  
   a. Explain the difference between a high-level language and an assembly language.
   b. Give four examples of system software?
   c. What is the job of a compiler?
   d. Classify computers according to their size.
   e. What is the use of a barcode reader? What does a barcode help to do?
Chapter 2 Formatting Data in Excel 2013

1. Fill in the Blanks
   a. ......................... refers to the position in which data is placed, within the boundary of a cell.
   b. Fonts can be selected from a Font group on the ......................... tab.
   c. There are 72 points in an inch when we talk about ......................... .
   d. You can mix your colours to get the desired colour on the ......................... tab.
   e. Ctrl + B key is used to make any text ......................... .

2. Write T for the true statement and F for the false one.
   a. Ctrl + I is used to make any text bold.
   b. Horizontal alignment can be left, right, or centre.
   c. Left, right, or centre are vertical alignments.
   d. The Currency command is part of the **Number** group.
   e. Excel 2013 has pre-designed cell styles.

3. Very Short Answer Questions
   a. Name the two different types of date formats.
   b. Which tab has the Cell Styles command?
   c. Name the different types of vertical alignment.
   d. What is the use of the Wrap Text command?

4. Short Answer Questions
   a. What is a font?
   b. Explain the process of merging data in cells.
   c. What is the difference between horizontal and vertical alignment?

5. Lab Exercise
   Observe the given information about the marks of a group of students in class X. Now do the following
   a. Replicate the data in a Marks.xlsx file.
   b. The first cell “Class X” has to be constructed by merging cells.
   c. Give the cell with the title a green background colour and yellow to all the other cells.
   d. The text should have horizontally centred alignment.
   e. Change the font to Verdana, size 12.

<table>
<thead>
<tr>
<th>Class X</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td></td>
<td>Marks</td>
</tr>
<tr>
<td>Aleena</td>
<td>425</td>
<td></td>
</tr>
<tr>
<td>Bobby</td>
<td>310</td>
<td></td>
</tr>
<tr>
<td>Dawood</td>
<td>460</td>
<td></td>
</tr>
<tr>
<td>Farooq</td>
<td>299</td>
<td></td>
</tr>
<tr>
<td>Ibrahim</td>
<td>475</td>
<td></td>
</tr>
<tr>
<td>Ismail</td>
<td>340</td>
<td></td>
</tr>
<tr>
<td>Javeria</td>
<td>320</td>
<td></td>
</tr>
<tr>
<td>Hamid</td>
<td>300</td>
<td></td>
</tr>
<tr>
<td>Abid</td>
<td>409</td>
<td></td>
</tr>
<tr>
<td>Sara</td>
<td>416</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 3  Advanced Features of Excel 2013

1. Fill in the Blanks  
   a. You can change the order of data in excel by using the ......................... option.  
   b. Selectively blocking data that you don’t want to see is known as ......................... .  
   c. The small black square at the lower right-hand corner of a cell is known as a ......................... .  
   d. You can add your own list to ......................... lists in Excel 2013.  
   e. Conditional formatting command is available in the ......................... group on the HOME tab.  

2. Write T for the true statement and F for the false one.  
   a. You can change the order of data by using the filter option.  
   b. Sorting is possible only by arranging data in ascending order.  
   c. You can conditionally format cells and highlight them with a different colour.  
   d. You can sort data by cell colour.  
   e. You cannot filter data by cell colour.  

3. Very Short Answer Questions  
   a. How will you create a series 1,3,5,7, 9,…, 22 in Excel?  
   b. Give an example of a list which is sorted by name.  
   c. Suppose in a given list in Excel containing name data, you have to display data in alphabetical order. Which option of Excel will you use?  
   d. What are the three types of filters in Excel 2013?  

4. Short Answer Questions  
   a. Differentiate between sorting and filtering.  
   b. What is conditional formatting?  
   c. What is the difference between flash fill and auto fill?  

5. Lab Exercise  
   See the information below on the heights of a group of children.  
   a. Open a test.xlsx file and input the above data.  
   b. Sort the data in the list above according to height from tallest to shortest.  
   c. Filter the data showing children with “above average” height.  
   d. Data for all the children with height >= 150 cm should be shown in red background. Give the steps.  

<table>
<thead>
<tr>
<th>Name</th>
<th>Height (in cm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abid</td>
<td>130</td>
</tr>
<tr>
<td>Bobby</td>
<td>141</td>
</tr>
<tr>
<td>Sohail</td>
<td>157</td>
</tr>
<tr>
<td>Daud</td>
<td>160</td>
</tr>
<tr>
<td>Essa</td>
<td>122</td>
</tr>
<tr>
<td>Javeria</td>
<td>115</td>
</tr>
<tr>
<td>Hareem</td>
<td>127</td>
</tr>
<tr>
<td>Isra</td>
<td>117</td>
</tr>
<tr>
<td>Jamshed</td>
<td>165</td>
</tr>
<tr>
<td>Kamal</td>
<td>168</td>
</tr>
</tbody>
</table>
Chapter 4  Introducing Publisher 2013

1. Fill in the Blanks (5)
   a. Microsoft Publisher is part of the ......................... suite.
   b. Template thumbnails are organised by ......................... type.
   c. The grey area on both sides of the card layout is the ......................... area.
   d. In a birthday greeting ......................... information stores your contact details.
   e. ......................... help you align text in Microsoft Publisher.

2. Write T for the true statement and F for the false one. (5)
   a. The red area on both sides of the card layout is the scratch area.
   b. The Status bar is located at the bottom of the Publisher screen.
   c. Publisher automatically hyphenates text when typed or pasted.
   d. “Grow text box to fit” shrinks the text so that it appears within the text box without overflowing.
   e. For changing the colouring of text boxes, you can use the Shape Fill option.

3. Very Short Answer Questions (4)
   a. What is the default extension of a Publisher file?
   b. How do you connect two text boxes in Publisher?
   c. Explain what is meant by Drop Cap text formatting style.
   d. Name the different types of guides.

4. Short Answer Questions (6)
   a. Name four types of professional documents you can create using Microsoft Publisher.
   b. What are ligatures?
   c. What is the use of the page navigation pane?

5. Lab Exercise (5)
   a. Prepare a New Year greetings card with the text “Wish you a great year ahead!”
   b. Choose green font.
   c. Use Lucida Calligraphy 12 as font and font size.
   d. Use Drop Cap feature for the text.
   e. Save the file as New Year.pub.
Chapter 5  Graphics in Microsoft Publisher 2013

1. Fill in the Blanks (5)
   a. Options to insert pictures and various shapes are available in the ......................... group on the INSERT tab.
   b. You can ......................... the picture in shape to remove its unwanted portions.
   c. Picture ......................... group provides artistic effects to the picture by changing the picture shape, border, and other effects.
   d. A ......................... is an explanatory or identification text or a title that accompanies a graphic.
   e. The scratch area is the ......................... area that appears around the publication page.

2. Write T for the true statement and F for the false one. (5)
   a. You can drag only one object to the scratch area.
   b. A thumbnail is a reduced size of a large graphic image.
   c. It is not possible to work with shapes in Publisher.
   d. Publisher only provides you with one type of building block—Page Parts.
   e. The Wrap Text button in the Arrange group has options to wrap the text around the picture.

3. Very Short Answer Questions (2)
   a. Name any two building blocks in Publisher.
   b. In which group is the Caption option found?

4. Short Answer Questions (8)
   a. What is the use of the scratch area?
   b. How many building blocks does Publisher support? Name them.
   c. What is meant by cropping a picture? How can you crop a picture in Publisher?
   d. What are the different sources of pictures in Publisher?

5. Lab Exercise (5)
   a. Prepare a poster for World Cup Football FIFA 2018: “Welcome FIFA World Cup Russia 2018” in the text box using an option from WordArt.
   b. Insert a picture of the world cup after searching for it on the Internet
   c. Apply a rectangular picture style to the poster with a golden background and an orange border.
Chapter 6  Basics of MS Small Basic

1. Fill in the Blanks  (5)
   a. A line in a program is called a .......................... .
   b. .......................... is the basic building block of Small Basic.
   c. If you want to assign a different name to an existing file, use the .......................... button.
   d. You can execute an MS Small Basic program by clicking the .......................... button.
   e. .......................... are data and values that cannot be changed in a program.

2. Write T for the true statement and F for the false one.  (5)
   a. There is only one type of constant.
   b. An Integrated Development Environment (IDE) has all the tools required for programming.
   c. The Editor is present at the top of the screen.
   d. Small Basic ignores white spaces.
   e. The first character of a variable can be numeric.

3. Very Short Answer Questions  (2)
   a. Explain the feature called “intellisense”.
   b. Name the different types of constants in Small Basic.

4. Short Answer Questions  (8)
   a. What is a program?
   b. What is an object in Small Basic? Give an example.
   c. What are the different types of variables allowed in Small basic?
   d. What are the different types of statements in Small Basic? What are conditional statements also known as?

5. Lab Exercise  (5)
   The length of a rectangular field is \( l \) metres and the width is \( w \) metres. \( l \) and \( w \) are inputs to the Small Basic Program. Ten students walk around the field ten times. Write a program to calculate the total number of kilometres travelled by all the students. (The distances walked by all the students have to be added).
Chapter 7  The Internet as a Post Office

1. Fill in the Blanks  
   a. ................................ lets you create a new email message.  
   b. Web page is a document written in ......................... .  
   c. ......................... is used to read HTML documents.  
   d. The front page of any website is called the ......................... page.  
   e. ......................... stores deleted messages.  

2. Write T for the true statement and F for the false one.  
   a. You can send an email to only one person at a time.  
   b. Modem is the short form for modulator-demodulator.  
   c. There is only one type of Internet addressing–Letter Addressing.  
   d. Sending emails is very costly.  
   e. Contacts stores email addresses of your friends and other persons you know.  

3. Very Short Answer Questions  
   a. Explain the attachment option in email.  
   b. What is a URL?  
   c. How can you search for information on the Internet?  

4. Short Answer Questions  
   a. What is the World Wide Web?  
   b. What are the different types of Internet addressing?  
   c. Name four important folders in Gmail.  
   d. What is the difference between the terms Cc and Bcc?  
   e. What is the difference between Forward and Reply?  
   f. What is DNS name resolution in the context of letter addressing?
Chapter 8  Introduction to Flash CS3

1. Fill in the Blanks (5)
   a. You can create ......................... using Flash software.
   b. ......................... is the white area in the centre of the screen.
   c. The ......................... tool is used to magnify or minimise a drawing.
   d. Ctrl N is used to open the ......................... dialog box.
   e. The ......................... tool is used to select irregular areas in a drawing.

2. Write T for the true statement and F for the false one (5)
   a. Flash provides five drawing modes for drawing shapes.
   b. Flash was first created by Macromedia.
   c. Ctrl + ‘ is the short cut key for displaying the grid.
   d. Flash does not allow you to enlarge a drawing.
   e. The Arrow Tool is also called the Selection Tool.

3. Very Short Answer Questions (2)
   a. Explain the use of the Arrow Tool in Flash.
   b. What is the smallest size of a frame in Flash?

4. Short Answer Questions (8)
   a. What is meant by Timeline in Flash?
   b. What are the various things you can create using Flash?
   c. Name the different areas of the Tools panel in Flash?
   d. Differentiate between the Merge Drawing mode and the Object Drawing mode.

5. Lab Exercise (5)
   a. Open a document in Flash.
   b. Insert a triangle.
   c. Place three circles intersecting the edges of the triangle.
   d. Do this for object drawing mode and merge drawing mode.
   e. Move the circles away and draw diagrams to show the the difference in the two modes.
Chapter 9  Drawing Tools in Flash CS3

1. Fill in the Blanks. (5)
   a. Squares are created using the ......................... tool.
   b. The colour of the outline of any shape is determined by the ......................... colour.
   c. The ......................... tool is used to draw polygons and stars.
   d. The ......................... option is used to draw freehand lines with no modification.
   e. The ......................... tool is used to change the colour, style, and thickness of an existing line.

2. Write T for the true statement and F for the false one. (5)
   a. The Paint Bucket Tool is used to erase lines and fills.
   b. You cannot reshape the shapes drawn using the Rectangle Primitive Tool.
   c. The Oval Primitive Tool is used to draw polygons and stars.
   d. It is not possible to draw rectangles with rounded corners.
   e. The Line Tool can be used to draw straight lines.

3. Very Short Answer Questions (6)
   a. While drawing a rectangle with rounded corners, what do you have to specify first?
   b. What is the use of the Paint Bucket Tool?
   c. What do you choose from the Tools panel while specifying a painting mode when you are drawing with the Brush Tool?
   d. Which tool do you use to fill enclosed areas with solid colours?
   e. How do you specify the line thickness while using the Line Tool?
   f. What attribute do you have to specify in Polystar Tool to specify the depth of a star?

4. Short Answer Questions (4)
   a. If you are drawing an oval shape, what are the properties that you should select and modify from the Property Inspector panel?
   b. Explain the process of creating a star using Flash.
Chapter 10  Creating Animations in Flash CS3

1. Fill in the Blanks
   a. A ......................... is the basic unit of any movie.
   b. A ......................... is a graphic image, animation, or button that is stored along with a movie.
   c. An ......................... is the occurrence of a symbol.
   d. F6 is the shortcut key for inserting a ......................... .
   e. In ......................... animation, you only specify the first and the last frame.

2. Write T for the true statement and F for the false one.
   a. In frame-by-frame animation, you have to specify only the first and the last frame.
   b. Shape tweening does not work on symbols.
   c. Library is a folder in Flash CS3 that stores symbols.
   d. Playhead is the basic unit of a Flash movie.
   e. For motion tweening, drawings must be converted into symbols.

3. Very Short Answer Questions
   a. Where are the symbols stored in Flash CS3?
   b. What is the use of the timeline?
   c. What are the different types of tweening animation?
   d. What is the short cut key for inserting a frame?

4. Short Answer Questions
   a. What is the difference between a symbol and an instance?
   b. What is the difference between a frame and a keyframe?
   c. What is the difference between frame-by-frame animation and tweening animation?

5. Lab Exercise
   Create an animation where a triangle changes into a square, which again changes into a pentagon, which finally becomes a circle.
Test Paper Answers

Chapter 1  The Computer System
1. a. mobile   b. Kindle   c. Minicomputers   d. Braille
2. a. F   b. T   c. F   d. T   e. F
3. a. LCD displays and plotters are also output devices.
   b. The two different categories of application programs are packages and utilities.
   c. Optical Character Reader is the full form of OCR.
   d. Basic and C++ are two examples of high-level languages.
   e. A utility is a program designed to do maintenance work on a system or on system components.
4. a. An assembly language is a machine-dependent low-level language where each instruction to the computer is written using a letter combination. High-level languages use English-like syntax in source programs and are more understandable than assembly languages.
   b. Operating systems, compilers, assemblers, and interpreters are types of system software.
   c. A compiler is a program that translates a high-level computer language program into a machine language program.
   d. On the basis of size, we can classify computers into five groups–mobile computers, microcomputers, minicomputers, mainframes, and supercomputers.
   e. Barcode readers are used to scan the barcodes on the body of any product. This is an input to the computer. The computer uses the barcode to identify the product.

Chapter 2  Formatting Data in Excel 2013
1. a. Alignment   b. HOME   c. Font size   d. Custom   e. bold
2. a. F   b. T   c. F   d. T   e. T
3. a. Short Date and Long Date are the two different date formats available.
   b. The Cell Styles command is present on the HOME tab.
   c. Top, middle, and bottom are the different types of vertical alignment.
   d. Wrap text helps the text to be placed in the same cell in multiple rows. It does not allow text to spill over to other cells.
4. a. A font is a set of letters of the alphabet and numbers written in a particular style.
   b. Select cells to be merged, click on Format cell, go to the Alignment tab and click on merge cells.
   c. Vertical alignment is top, middle, or bottom whereas horizontal alignment is right, left, or centre within a cell.
5. a. Open and save an Excel 2013 file called Marks.xlsx
   b. Take the two cells A1 and B1 and merge it. Insert data “Class X” inside the merged cell.
   c. Place data “Name” and “Marks” in cells B1 and B2.
d. Insert marks data (names and marks) for each student starting from C1:C2, D1:D2, and so on according to the table provided.

e. Select all the data, click the Borders drop down menu arrow and select All Borders in the menu.

f. Select A1:A2 (merged cells), click the Fill Color option and fill the merged area in orange.

g. Similarly, select all the cells in the table from B1:B2 downwards and fill it with yellow colour.

h. Select the area of the data (A3:B12) and choose Centre in the Alignment group.

i. Select the full table. Click the drop down menu arrow of the Font command in the Font group and select Verdana in the list. Click the drop down menu arrow of the Font Size command in the Font group and select 12 as the size.

---

Chapter 3  Advanced Features of Excel 2013

1. a. sorting   b. filtering   c. fill handle   d. Custom   e. Styles
2. a. F   b. F   c. T   d. T   e. F
3. a. In order to create a series like 1, 4, 7, ..., 22, type 1 in a cell, then type 4 in the cell immediately below. Select both the cells and drag the data by the fill handle to get the other numbers of the series.

b. A telephone directory is a list sorted by name.

c. You will use the sorting option on name data to display the data in alphabetical order by name.

d. You can filter data by a list value, by a format or by a criterion in Excel 2013.

4. a. Sorting rearranges data in a specified order, while filtering selectively blocks or hides data you don’t want to see.

b. Setting cell formatting according to conditions specified by the user is called conditional formatting.

c. Autofill is a feature that lets you quickly fill a range of cells with a series of data without typing it. Flash fill is a feature that recognises the data pattern in a series of cells and fills the data series in the column.

5. a. Open a test.xlsx file and input the data with relevant colour fills as shown in the table.

b. Click the DATA tab. In the Sort & Filter group, click the Sort Largest to Smallest button. The data will first be sorted in the descending order of height.

c. Select the header Height (in cm). Click the Filter button to enable filter in the cell. Click the drop down menu arrow, select Number Filters in the drop down menu. Choose option Above Average from sub-menu.

d. Select A2 to B11. Click Conditional Formatting and in the drop down menu click New Rule. Under the Select a Rule Type box, click Use a formula to determine which cells to format. Under “Format values in which this formula is true” type =$B2 >= 150. Click Format… , click the Fill tab and choose red as the background colour.

---

Chapter 4  Introducing Publisher 2013

1. a. Microsoft Office   b. publication   c. scratch   d. business   e. Guides
2. a. F   b. T   c. F   d. F   e. T
3. a. The default extension of a Publisher file is .pub.
   b. Click the **FORMAT** tab under **TEXT BOX TOOLS**, and select **Create Link** option in the **Linking** group.
   c. In **Drop Cap Text** formatting style, only the first letter of the text is enlarged and in some cases it is the dropped below the first line.
   d. There are two types of guides—margin guides and Customisable guides.
4. a. Publisher allows you to create professional documents such as brochures, labels, cards, and certificates.
   b. Ligatures are connections between characters that seem to create a single character out of two or more characters.
   c. The page navigation pane allows you to view and work with all the pages in your publication. You can view the page thumbnails and add, delete, rearrange, and duplicate pages in this pane.
5. a. Open a suitable “Holidays” template in Publisher 2013.
   b. Go to the Backstage view and save the file as New Year.pub
   c. On the **HOME** tab, in the Objects group select Draw Text Box.
   d. Type the message “Wish you a great year ahead!”.
   
   Click the **FORMAT** tab under **TEXT BOX TOOLS**, and in the Font group select font as Lucida Calligraphy, Font Size as 48, and Font Colour as **green**.
   e. On the **FORMAT** tab under **TEXT BOX TOOLS**, and in the Typography group select **Drop Cap** to stylize the greeting.

---

**Chapter 5  Graphics in Publisher 2013**

1. a. Illustrations  
   b. crop  
   c. Styles  
   d. caption  
   e. grey

2. a. F  
   b. T  
   c. F  
   d. F  
   e. T

3. a. **Page Parts** and **Calendars** are two of the building blocks available in Publisher.
   b. The **Caption** option is found in the **Picture Styles** group.

4. a. Scratch area is the grey area that appears around the publication page. It can be used as a temporary holding area. If you are not sure where you want to move an item, you can drag it to the scratch area.
   b. Publisher provides four types of building blocks—Page Parts, Borders and Accents, Calendars, and Advertisements.
   c. Cropping a picture is used to remove the unwanted portions in a picture. For cropping a picture, select the Format tab in the Picture Tools tab and click the drop arrow of the Crop button. You can choose different crop options here.
   d. There are three sources for pictures in Publisher. You can browse for picture files in your computer, search for them in Office.com Clip Art or search on the web via Bing image search.

5. a. Open Publisher and create a blank document.
   b. To create a text box:
      
      On the **HOME** tab, select the **Draw Text Box** button in the **Objects** group.
c. Click the FORMAT tab under DRAWING TOOLS and in the Shape Styles group, do the following:
   i. Click Shape Fill to colour the text box with golden colour.
   ii. Click Shape Outline to colour the border of the text box with orange colour.

d. To insert a picture of the World Cup in your publication:
   i. Click the INSERT tab.
   ii. In the Illustrations group, click the Online Pictures button. The Insert Pictures dialog box appears.
   iii. In Bing Image text box, type World Cup Football and press ENTER.
   iv. Select the required picture and click Insert. The picture gets inserted in the publication.

e. You can resize the picture and change its style.

f. To insert WordArt text in your publication:
   i. Click the INSERT tab.
   ii. In the Text group, click WordArt. The WordArt styles will appear.
   iii. Select the required style. The Edit WordArt Text dialog box appears.
   iv. Enter the text “Welcome to FIFA World Cup Russia 2018” in the publication and click OK.
   v. Resize the text box.
   vi. Save your publication as WorldCup.pub.

---

Chapter 6 Basics of MS Small Basic

1. a. Statement    b. Object    c. Save As   d. Run    e. Constants
2. a. F    b. T    c. F    d. T    e. F
3. a. As we type a line of code in MS Small Basic, a popup window appears which gives us suggestions on choosing a command. This feature is called intellisense.
    b. In Small Basic constants are of two kinds, numeric constants and string constants.
4. a. A program is a sequence of instructions written to perform a particular task. It instructs the computer what to do and how to do it.
    b. An object is the fundamental building block of Small Basic. For example, TextWindow is an object, which is a window that displays the output of a program.
    c. There are two types of variables allowed in Small Basic - numeric type and string type. In addition, the numeric type variables can be sub-divided into integer type and floating type.
    d. Small Basic has assignment, conditional, and looping statements. Conditional Statements are also called branching statements.
5. a. The code will be as follows:

   TextWindow.write ("Enter the length of the field in metres")
   l = TextWindow.ReadNumber( )
   TextWindow.write ("Enter the width of the field in metres")
w = TextWindow.ReadNumber( )

D = (2*(1+ w)*10*10)/10000 ' The total distance covered by 10 students who run across the
field 10 times in kilometres.

TextWindow.WriteLine ("The total distance travelled by the 10 students who ran across the
field 10 times is “ + D + “kilometres”)

Chapter 7 The Internet as a Post Office

1. a. Compose  b. HTML  c. Web Browser  d. Home  e. Trash
2. a. F  b. T  c. F  d. F  e. T
3. a. Attachment option allows you to attach and send files, such as a Word, Excel, or JPEG file, along with
the email. This option appears when you are composing a message.
   b. A URL or Uniform Resource Locator is a unique address for a website or a web page on the Internet.
   c. You can search for information on the Internet by using search engines like Google or Yahoo.
4. a. The World Wide Web, or simply the Web, is the world-wide collection of publicly accessible Web pages
stored on computers connected to the Internet. It is easy to retrieve information from the Web, and this
has helped to popularise the Internet.
   b. There are two types of Internet addressing–Number Addressing and Letter Addressing.
   c. Inbox, Draft, Sent Mail, and Contacts are four important folders in Gmail.
   d. In Cc you send the same message to several people at the same time. In Bcc you send the same message
to many people at the same time but without letting them know that others have also received the same
message.
   e. In Reply you answer, i.e. send a mail back to the person who sent you a mail. In Forward you send a
mail sent by someone to someone else.
   f. When you enter a letter address in a browser, the Internet sends the information to DNS servers that
translate the letter address to the corresponding IP address. This process is called DNS name resolution.

Chapter 8 Introduction to Flash CS3

1. a. animations  b. Stage  c. Zoom  d. New Document  e. Lasso
2. a. F  b. T  c. T  d. F  e. T
3. a. The Arrow Tool, also called the Selection Tool, is used to select single or multiple objects on the stage.
   b. The smallest size of a frame in flash is 1 × 1 pixel.
4. a. Timeline is the panel in a Flash window used to set the sequence of a movie.
   b. Flash can be used for creating interactive Web pages that combine images, sounds, videos, and animations.
   You can also use Flash to create drawings and animations.
c. The Tools panel is divided into four areas
   • Tools area
   • View area
   • Colours area
   • Options area

d. Merge drawing mode erases the overlapped area of the underlying object and the two objects merge.
   Object drawing mode considers overlaid objects as separate.

5. a. Open a new document in Flash.
   b. Choose Merge Drawing mode.
   c. Insert a triangle.
   d. Place three circles at the three corners of the triangle, intersecting the triangle edges slightly.
   e. Move the object away. You will see that the edges of the triangle are erased.
   f. Repeat steps (a) to (d), but this time choose Object Drawing mode in step (b).
   g. We see that the original triangle can be seen even when the circles are moved away.

Chapter 9 Drawing Tools in Flash CS3


2. a. F  b. F  c. F  d. F  e. T

3. a. When you draw a rectangle with rounded corners, you first have to specify the radius for the corners
   and then draw the shape.
   b. The Paint Bucket Tool is used to fill enclosed areas with solid colours and gradients.
   c. You choose a Brush Mode Modifier from the Tools panel while specifying a painting mode. You can
      also select the desired brush shape and size.
   d. You use the Paint Bucket Tool to fill enclosed areas with solid colours.
   e. You use the Property Inspector’s Line thickness option to specify the line thickness before using the Line
      Tool.
   f. We have to specify the Star Point size attribute in order to set the depth of the star while drawing a star
      using the Polygon Tool.

4. a. While using the Oval tool use the Property Inspector panel to set the properties—start angle, end angle,
   and inner radius.
   b. For drawing a star you have to select the Polystar Tool from the drop down menu of the Rectangle Tool.
      In the Property Inspector select stroke and fill attributes. Click options button from Property Inspector
      and see the Tool settings. Select Star for Style. Select number of sides. Specify the Star Point size which
      sets the depth of the star which should be a value between 0 and 1.
Chapter 10  Creating Animations in Flash CS3

1.  a. frame  b. symbol  c. instance  d. keyframe  e. tweened

2.  a. F   b. T   c. T    d. F    e. T

3.  a. Symbols are stored in the Library folder in Flash CS3.
   b. The Timeline is the area where you work with frames to organise and control the content and animation of your movie.
   c. There are two types of tweening animation, motion tweening and shape tweening.
   d. F5 key is the shortcut key for inserting a frame.

4.  a. A symbol is a graphic image, animation, or button that is stored along with a movie. It can be inserted in the movie as many times as you want, i.e. symbols are reusable graphics. An instance is an occurrence of a symbol. Each time you insert a symbol in a movie, you create an instance of that symbol.
   b. A frame is the basic unit of any movie. It contains the content of any movie. A keyframe is a critical point in the animation when an object appears or changes.
   c. In frame-by-frame animation you have to provide every frame, whereas in motion tweening you can provide only the first and the last keyframes.

5.  a. Use Shape tweening for this exercise.
   b. Select the first frame and draw a triangle
   c. Select frame 40 in the timeline window and insert a keyframe.
   d. On frame 40 select the drawing object, delete it, and insert a square.
   e. Similarly on frame 80, insert a pentagon and remove the square and finally on frame 120, insert a circle and remove the triangle.
   f. Click any frame between 1 and 40. In the Property inspector panel, select Shape from the Tween drop down list.
   g. Repeat step (f) on any frame between 40 and 80, and 80 and 120.